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Welcome to Macro Express Pro 
 

Macro Express is the premier macro utility on the market. Use Macro Express to record, edit and play back mouse and 
keyboard macros. Its powerful tools and robust features will noticeably boost productivity.  

 

 
What is a Macro? 
A macro is a set of written or recorded commands that can be played back at will to perform a specific task. These tasks 
can be as simple as inserting a name and address into a word processor to something more complex such as launching a 

program, copying data from it, activating another program, pasting the data into it and repeating the steps several times.  

  

Tasks performed by macros are typically repetitive in nature allowing significant savings in time by executing the macro 
instead of manually repeating the commands. 

  

Creating a Macro 
There are several methods available to create macros with Macro Express. The simplest is to capture (record) keystrokes 

and mouse movements. Another method is to use the Quick Wizards to build a macro through a series of  questions and 

prompts. Or build more complex macros with the easy to use Script Editor or Direct Editor. The tutorial provides 
examples of creating macros using each of these methods.  

  

Playing Back a Macro 
Macro Express provides a number of methods for executing macros. These include the use of Hot Keys, Shortkeys, 

Scheduled Macros, Window Activation, Mouse Clicks, Popup/Floating Menus and others described below. 

  

1. A Hot Key is a set of keys on the keyboard that are pressed to initiate the macro. This  could include pressing 
CTRL+ALT+R or CTRL+F12 or any number of combinations.  

2. A Shortkey is a small string of characters. When a matching combination is typed on the keyboard, it is erased 

and the assigned macro executes. For example, type a small string such as #add to insert an address into 
another application.  

3. A Scheduled Macro executes on a given time schedule.  

4. A Window Activated macro runs when a specific window gains focus (appears) on the computer screen. 

5. Trigger a macro by clicking on a specific area of the screen with the left, right or middle Mouse button.  

6. A Popup Menu or Floating Menu is basically a list of defined macros. Once the list is displayed, click on the 

desired macro or press an associated number or letter to execute the macro.  

7. Activate a macro through a Batch File or Command Line. 

8. Execute macros by using Windows API calls or Windows Explorer. 

9. Run a macro from the Macro Explorer by using the Run Macro Now option. 

10. Start a macro when a particular word or phra se is copied to the Clipboard. 

11. Invoke a macro when the information in a specified File or Folder changes. 

12. Activate macros when a Process starts or stops running or when the TCP/IP stack becomes available or 

unavailable. 

13. Trigger macros from a System Event, such as a Windows message, screen resolution or color change. 

  

Macro Scopes 
Macro scopes may be used to place restrictions on macros. Assign macros to play back in all Windows programs, in one 



specific window or program, or in every program except the one selected. The tutorial  section also provides a few 

examples of how to do this.  

  



 

Program Overview 
 

Macro Express is a utility designed to automate repetitive computer tasks. This guide explains a few basic concepts of 
Macro Express to provide a better understanding of the 

program.                                                                                                                                                               

                            

Starting Macro Express 
After installing the program, click on Start | Programs and open the folder chosen for the shortcut (by default it is Macro 
Express). Click on the Macro Express Pro shortcut to start the program. If Macro Express is placed in the StartUp folder 

during the installation process, Macro Express will load each time the computer is started. 

  

Choose to have the program run in hidden mode or place an icon in the System Tray. Click on Options | Preferences | 
General | System Tray to make the selection. If running in hidden mode, the default hot key is CTRL+ALT+SHIFT+W to 

activate the program window.  

  

Player and Editor 
Macro Express is split into two parts known as the Macro Express Player and the Macro Express Pro - Explorer. The Macro 

Express Player is what executes the macros and it must be running in order for macros to play back. The Macro Express 
Editor is the tool used to display macros and open other program components for creating macros.   

  

When Macro Express is started, it is actually the Macro Player that is running. By default, the Explorer also runs when 

Macro Express is started, but this can be changed so that it does not start automatically. Click on Options | Preferences | 
Startup to make the change. The Explorer cannot be run by itself.  

  

By default, the Macro Express Player displays an icon in the system tray. Use this icon to invoke the Macro Express Pro - 

Explorer or shut down the Macro Express Player. Or optionally set the Macro Express Player to be completely hidden so 
that no icon shows in the system tray. In hidden mode, use the System Macros to invoke the Explorer or terminate the 

program. 

  

Macros 
A macro is a script containing commands that automate computer tasks. Each command performs one step, such as 

moving the mouse, launching a program or entering keystrokes.  

  

There are several methods within the Macro Express Pro - Explorer to create a macro. Using the Quick Wizards or 
Capture are the simplest. The Quick Wizards ask a series of questions and build the macro. To Capture a macro, start the 

Capture, enter the keystrokes and mouse movements, and then stop the Capture process. Use the Script Editor or Direct 
Editor for more control i n writing macros.  

  

Macro Activation 
Once written, a macro needs an action to cause it to play back. The macro activation might be a combination of 

keystrokes, a mouse click in a certain area of the screen or a macro may launch when a program starts up.  

  

Files and Categories 
Macro Express allows for the creation of multiple files of macros. When first installing the program, the macex.mex  file 

is created. It is an empty file that can be used to store the macros as they are created. This file is installed i n the My 
Documents folder. 

  

Create new macro files by clicking on File | New Macro File from the Macro Explorer. Or import macros from one file to 

another by clicking on File | Import Macros. Note:  The bottom right hand corner of the Macro Explorer window  displays 
the macro file name and path of the file currently in use.  

 

Each macro file allows for the use of categories in order to organize macros in that file. For example create a Password 

category to hold any macros containing important passwords or assign any MS Word specific macros to a MS Word 
category. The categories provide a simple way to find macros after they have been created. A macro may only be 

assigned to one category. 

 
When a macro file is first created or when using the default macro file f or the first time, there are two default categories 

- All Categories and Unassigned. These may not be changed, but new categories may be added, or later deleted or 
renamed. All Categories displays all of the macros in the file. The Unassigned category displays all macros not assigned to 

a category other than All Categories. The category icons may be turned on or off via the Macro Express Pro - Explorer 



menu Options | Preferences | Appearance | Explorer tab. 

  



 

Program Navigation 
 

Macro Express consists of several components. The major components of the program can be accessed by clicking on the 

icons in the Actions column. These components may also be accessed through the menu commands. Each of these 

components are discussed briefly below. Links are provided for more detailed information about each component.  

  

Macro Explorer 
By default, the program opens to the Macro Express Pro - Explorer. This displays the list of macros in the file currently 
open. When saving macros in the editors or other options, the p rogram returns to the Macro Explorer.  

  

New Macro 
Click on the New Macro button to start the process of building a macro in the Script Editor or Direct Editor. The first step 

prompts to select an activation method and assign a name to the macro. The next s tep opens the Script Editor to begin 

creating the macro. The Script Editor is the default editor. If desired, click on the Direct Editor icon  while in the 
Script Editor to switch to the Direct Editor.  

  

Edit Macro 
Highlight a macro from the list of already created macros. Click on the Edit Macro button to open the Script Editor and 
display the macro. Or double click on the macro in the list to open it in the Script Editor.  

  

Capture 
This button starts the process for recording or capturing a macro. Keystrokes and mouse clicks/movements are recorded 

and saved. 

  

Quick Wizards 
This option opens the Quick Wizards. There are 25+ different wizards to guide users step by step through the creation of 

various macro types. 

  

Recycle Bin 
Macro Express has its own recycle bin. Any macros deleted from the Macro Explorer are sent to the Recycle Bin. If one is 
deleted by mistake the macro can be restored to its original file. Or if the deleted macros are definitely no longer needed , 

they can be removed permanently. 



 

What's New in Macro Express Pro 
 

Macro Express Pro has a modernized look and a number of exciting new features. Below is a partial list of what's new in 
the program.  

  

1. Run more than one macro at the same time 

Now start a second (or third) macro while the first macro is still running. The macros will play back simultaneously.   

 

2. Script Editor enhancements 
The Script Editor allows more than one macro script to be open at the same time. This makes it easier to copy s ections 
from one macro to another.  

 
Now change the color of the text on individual lines in the script or highlight the field a specific color to help find 

particular lines of code.  
 

Save blocks of code as snippets that can be easily inserted into other macros. 

  

3. Multiple macro files loaded at same time 
Macro Express Pro allows more than one macro (.mex) file open at the same time. Macros will play back from any of the 

files that are currently open.  

  

4. Improvements to variables 
Now name the variables rather than use T1, D1, N1 designations. The old variable naming system is still in place for 

backward compatibility. 

 
Several new types of variables are available. These include Boolean variables, Handle variables and Date/Time variables 

for making date/t ime calculations. 

  

5. New macro activations 
The following macro activations have been added to the program.  

 
Directory Modification 

This activation type looks for changes to files or folders. When a change is made to the file or folder specified, the macro 
will start. Among the options, the macro may look for changes to file size, attributes, write time, security descriptor or if  a 

file has been renamed or deleted. 

  

System Event 

The macro activates when a System Event, such as a Windows message, resolution change or color change occurs. 

  

Process Event 

Trigger a macro when a process starts or ends. 

  

TCP/IP 

This options looks for the TCP/IP stack to become available or unavailable. 

  

Clipboard Text 

Activate a macro based on the contents of the clipboard. Select whether the clipboard does or does not match what is 

selected as the clipboard trigger. Or choose whether the clipboard contains or does not contain specific text.   

 

6. New macro commands 
¶ The GoTo and Label commands allow the macro to move to any line in the script, forward or backward, during 

playback. 

¶ The External Script command runs supplied JScript, VBScript or HTA scripts. 

¶ Added math commands such as sine, cosine, minimum and maximum values and more. 

¶ Commands have been added to easily join or split text string variables. 

¶ Error handling and debugging have been improved. 

¶ The Text Box Display command now supports Rich Text allowing messages to be displayed in various fonts, 

sizes, colors, etc. 

¶ The Update Text Box command updates the text box displayed during macro runtime with fresh information.  



¶ Functions to lock the keyboard and mouse during macro playback so that users don't accidentally interfere.  

  
7. Enhanced password protection 
Beefed up the password protection to make the macro files more secure.  

  

8. Quick capture routine 
Added a quick capture option to quickly capture a temporary  macro with a system hot key. A separate system hot key 

plays back the temporary macro.  

  

  

  



 

Converting from v3 to Macro Express Pro 
 

By default, Macro Express Pro installs to a different folder than Macro Express 3. 

  

1. Macro Express Pro allows more than one macro to run simultaneously. When importing or opening a v3 macro file in 
Macro Express Pro, you will see the message displayed below. Answer Yes to place a File Lock command in each of the 

macros being converted. This prevents the macro from playing while another macro is already running.  

  

 
  

2. Macro Express 3 files converted to the Macro Express Pro file format cannot be converted back to the older format. 

Keep backup copies of the version 3 macro files if you ever intend to revert back to Macro Express 3 use. 

 

When converting the file to the Macro Express Pro format, a backup copy of the file in Macro Express 3 format is created. 
The backup is saved to the same location as the original file. 

  

3. Macros written to automate Macro Express may not convert properly because the Macro Express Pro window titles 

have changed from v3. The accelerator keys have also changed. 

  

  

  



 

Installing Macro Express 
 

The steps for installing Macro Express Pro are fairly standard. 
   

1. First download the program from www.macros.com/download.htm .  

 

2. Save the downloaded file to a folder on your hard drive.  
   

3. Locate the downloaded file and double click the .exe file to start the installation process.  
   

4. Follow the on screen instructions to complete the install.  

  

If not familiar with Macro Express, please read through the Introduction and Tutorial sections of the Help file. 

  

Licensing Macro Express Pro 
If you have purchased the license for Macro Express you will also receive a license code. From the Macro Explorer click 
on Help | License Macro Express to activate the License Information window. Enter your name and code exactly as they 

appear on the license instructions you received when you purchased Macro Express. Press OK to save the license 
information. Your license status will now display in the lower left corner of the Macro Explorer window.  

  

See the Advanced License Information topic for consideration of Administrator and non -Administrator login rights  and 

Macro Express licensing. 



 

Advanced Installation 
 

Silent Install  
A silent install means Macro Express will be installed without the user having to answer any questions during the 

installation process. This is helpful when installing Macro Express from within another setup program or when installing 
from a server on a network.  

  

The /S command line parameter instructs the Macro Express installer to do a Silent Install. For example: macexpro.exe /S  

  

Note:  The Macro Express installation file may be named setup.exe or macexpro.exe depending on where the file was 

obtained. In the examples shown, substitute the actual name of the Macro Express installation file. If the installation file 
was downloaded in zip format, first unzip setup.exe or macexpro.exe from the zip file before running a Silent Install.  

  

Installation options  
The Macro Express Install program allows for using a text file to automatically respond to the install questions during the 

installation process. By putting entries in the text file, choose things such as where to install the program, whether Macro 
Express should be put in the Startup folder so it is automatically launched when Windows starts, or whether the Quick 

Start Guide should be displayed after Macro Express is installed.  

  

In order to do this, first create a text file, name it and use the /M= command line parameter. For this example, we will 

name the file MEProSetup.txt.  

  

macexpro.exe /M=c: \MEProSetup.txt  

  

These are the options that may be placed in the setup file:  

  

INSTALLPATH is used to override the default installation folder. If included, Macro Express is installed in the folder 

specified by INSTALLPATH. 

INSTALLPATH=c:\myprograms\Macro Express 

  

STARTMENUFOLDR is used to override the default start menu used to load Macro Express. If included, the menus to start 

Macro Express are placed in the folder specified by STARTMENUFOLDR. 

STARTMENUFOLDR=Utilities 

  

STARTUP=Y puts Macro Express in Windows StartUp folder. 

STARTUP=N does not put Macro Express in Windows StartUp folder. 

  

LAUNCHNOW=Y Launches Macro Express after installation is completed. 

LAUNCHNOW=N does not Launch Macro Express after installation is completed 

  

NOQUICKSTART=Y does not install the Quick Start Guide. 

NOQUICKSTART=N installs the Quick Start Guide (default).  

  

QUICKSTARTNOW=Y displays Quick Start Guide after installation is completed or when Macro Express starts (default). 

QUICKSTARTNOW=N does not display Quick Start Guide at the end of the installation.  

QUICKSTARTNOW=P  Prevents the Quick Start Guide from being displayed when Macro Express starts. 

QUICKSTARTNOW=NP does not display Quick Start Guide at the end of the installation and also prevents the Quick Start 
Guide from being displayed when Macro Express starts. 

  

Note:  NOQUICKSTART prevents the Quick Start Guide from even being installed. QUICKSTARTNOW just prevents the 

Quick Start Guide from being displayed. When using QUICKSTARTNOW the Quick Start Guide can be installed but not 
automatically displayed. 

  

WHATSNEWNOW=Y Displays What's New in this version after install 

WHATSNEWNOW=N does not display What's New in this version after install  

  

REBOOT=N suppresses the dialog suggesting a reboot after installation is completed, even if the installer has de termined 

that one is needed. 

  



LICENSENAME and LICENSECODE are used to license the software during install:  

LICENSENAME=Name used when Macro Express was licensed 

LICENSECODE=Code received when Macro Express was licensed 

  

CONFIGFILEPATH= path to optional c onfiguration file. This allows for setting a specific configuration of Macro Express at 

the time the program is installed.  

  

To do this, install Macro Express on a computer and set the preferences to desired settings. Follow by clicking Tools | 

Export Program Configuration to create a file containing the preferences. Then add CONFIGFILEPATH=c:\macexpro.wcfg 

to the MEProSetup.txt file. 

  

This example assumes the preference information has been saved in the file c:\macexpro.wcfg. 

  

NOEDITOR=Y does not install the Macro Express Editor. 

NOEDITOR=N installs the Macro Express Editor (default). 

  

NOHELP=Y does not install the Help file.  

NOHELP=N  installs the Help file (default).  

  

NOICONS=Y does not install the sample icons. 

NOICONS=N installs the sample icons (default). 

  

INSTALLOLDER=Y installs all files even if they are older than files already in the destination folder.  

INSTALLOLDER=N does not overwrite newer files in the destination folder (default).  

  

MACROFILEDEST=Path and filename of where t o install the macro file macexinstall.mex, if it exists.  

  

This option instructs the installer to copy a macro file named macexinstall.mex to the destination and name you specify. 

It does not instruct Macro Express Pro to load the macro file when it starts . Use the CONFIGFILEPATH option to specify 
which macro file(s) to load when Macro Express Pro runs. The macro file macexinstall.mex must exist in the same 

directory as the install file.  

  

When the MACROFILEDEST installation option is not used, the macro file is installed in the current user's My Documents 
folder and the name of the macro file is macex.mex.  

  

The RUNQUIET option is helpful when installing Macro Express Pro on a network with many users. This option sets 

several default installation values to suppress from end users the information prompts that are typically displayed during 
the install process. 

  

RUNQUIET=N the program's default values are used for the preferences 

RUNQUIET=Y the preferences are set to install and run quietly. These options apply to the user installing the program 

and any new users: 

      - The Splash Screen is disabled 

      - The Editor is not loaded when the program starts  

      - The Quick Start Guide is not displayed 

      - The What's New document is not displayed 

      - Keyboard Remapping is disabled 

      - Backups are disabled 

      - The First Time setup wizard is disabled 

      - Macro Halted messages are suppressed 

      - The system tray balloon is not displayed 

      - The message asking about file associations is disabled 

  

Note:  Do not include spaces either before or after the = character.  

The Run Quiet=Y option takes precedence over the configuration settings in the ConfigFilePath option. 

  



Sample Text File 
 

Using Notepad, or some other text editor, create the file MEProSetup.txt containing the 

following:  
  

INSTALLPATH=c:\Program Files\Example  

STARTMENUFOLDR=Macro Express Pro 

STARTUP=N  

LAUNCHNOW=N  

QUICKSTARTNOW=N  

REBOOT=N  

LICENSENAME=Jason Junior 

LICENSECODE=AB3EG-45F9X-1Q200-34CCW-45UNL  

  

Note: The License Information is for demonstration purposes only. You should use the 
License Information you received when you purchased Macro Express Pro.  

  

This example installs Macro Express into c:\Program Files\Example. The start menu will be 

Macro Express Pro. Macro Express will not be launched when Windows is started. Macro 
Express will not run at the end of the install. The Quick Start Guide will not be  displayed at 

the end of the install. The setup will not reboot the computer. After the installation is 

complete, the program will be licensed to Jason Junior. 

  

Note:  Only insert valid options into the MEProSetup.txt file. Do not include comments, 

blank lines or remarked out options.  

  

Silent Install with Options  
The Silent Install may be combined with the Installation Options listed above. After creating MEProSetup.txt install Macro 

Express Pro with the following command:  

  

macexpro.exe /S /M=c: \MEProSetup.txt 



 

Advanced License Information 
 

Windows can be configured to allow different users to log onto a single computer. Some versions of Windows require a 
user to log in. Normally only one user is logged in at a time. One or more login names have access to the entire 

computer and are said to have administrative access rights. Other login names do not have administrative access rights. 

These login names have restrictions about what they can change on the computer.  

  

If the Name and Code are entered into the License Information dialog when logged in as an administrator, Macro Express 

Pro is licensed for all users. If, however, the License Information is entered when logged in as a non -administrator, Macro 

Express Pro is only licensed for that user login. 

  

Generally the above is not pertinent for Windows 95, 98 or ME since by default all users have administrative access 

rights. This only becomes an issue when using Windows NT, 2000, XP, Vista or later and there is more than one login 

name for the system. 



 

Uninstalling Macro Express 
 

To remove Macro Express from the computer follow the steps below:  

  

1. Click on File | Exit Program to close Macro Express.   

2. From the taskbar, click the Start menu button to open the Start menu.  

3. Open the Windows Control Panel.  

4. Based on the version of Windows you are running, select the option from the control panel used to uninstall 

applications.  

5. Highlight Macro Express Pro in the list of installed programs. 

6. Again, depending on your version of Windows click on the option to remove the program.  

7. Follow the on-screen prompts to remove Macro Express from your computer. 

  

  



 

Tutorial - Introduction 
 
A macro is a set of commands that can be played back at will to perform a given task. These tasks can be something 
simple such as inserting your name and address into a word processor to something more complex such as launching a 

program, copying data from it, activating another program, pasting the data into it and  repeating this several times. 

Tasks performed by macros are typically repetitive in nature allowing significant savings in time by executing the macro 
instead of manually repeating the commands. 

 

Macro Creation 
There are several methods available to create macros with Macro Express. The simplest is to capture (record) keystrokes 
and mouse movements. Another method is to use the Quick Wizards to build a macro through a series of questions and 

prompts. Or build mor e complex macros with the easy to use Script Editor or Direct Editor. This tutorial section provides 

examples of creating macros using each of these methods.  
 

Macro Playback Options 
1) A Hot Key is a set of keys on the keyboard that are pressed to initiat e the macro. This could include pressing 

CTRL+ALT+R or CTRL+F12 or any number of combinations. 

2) A Shortkey is a small string of characters. When a matching combination is typed on the keyboard, it is erased 
and the assigned macro executes. For example, type a small string such as #add to insert an address into 

another application. 

3) A Scheduled Macro executes on a given time schedule. 
4) A Window Activated macro runs when a specific window gains focus (appears) on the computer screen. 

5) Trigger a macro by clicking on a specific area of the screen with the left, right or middle Mouse button.  
6) A Popup Menu or Floating Menu is basically a list of defined macros. Once the list is displayed, click on the 

desired macro or press an associated number or letter to execute the macro.  

7) Activate a macro through a Batch File or Command Line. 
8) Execute macros by using Windows API calls or Windows Explorer. 

9) Run a macro from the Macro Explorer by using the Run Macro Now option. 
10) Start a macro when a particular word or phrase is copied to the Clipboard.  

11) Invoke a macro when the information in a specified File or Folder changes. 

12) Activate macros when a Process starts or stops running or when the TCP/IP stack becomes available or 
unavailable. 

13) Trigger macros from a System Event, such as a Windows message, screen resolution or color change. 
 

Macro Scopes 
This guide will also discuss the scope of a macro - or the restrictions you have placed on the macro. You can assign 
macros to play back in all Windows programs, in one specific window or program, or in every program except the one 

you define. The Macro Scopes tutorial shows how this works. 



 

Creating a Hot Key Macro 
 

In this exercise we will create a macro assigned to a hot key. When complete, pressing the hot key will run the macro.  

  

Setting up the Macro and Assigning the Hot Key 
1. From the Macro Express Pro - Explorer menu click on Macro | New Macro to open the Create New Macro window.  

2. Hot Key should already be selected as the Initial Activation and the blinking cursor should be in the edit box.  

3. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.  

4. Hold down the CTRL key, the SHIFT key and the T key at the same time and release them. 

5. CTRL+SHIFT+T should appear in the edit box. This is the hot key we will define for the macro.  

6. Enter "My Address" in the Nickname field.  

7. Click OK to open the Script Editor.  

8. Next, click on View | Direct Editor to open the Direct Editor, which we will use to create the macro.  

 

Other methods to create macros are via the Quick Wizards or capturing (recording) a macro. These options are reviewed 
in other sections. 

  

 
The Direct Editor looks like the screen shot above.   

  

  

Creating the Macro 
1. In the edit field, type in your address.  

2. Click on the Scope Tab and make sure Global is selected. Global is the default option. 

3. Click on the Save and Close button to save the macro and close the Editor.  

4. Open the Macro Explorer window to see the newly defined macro, My Address, added to the list of available 

macros. 

  

  

Playing Back the Macro 
1. First, let's run the notepad program. (To run notepad, click on Start | Run from the bottom left of the computer 



screen, enter notepad and click the OK button.)  

2. Once notepad is running, hold down the CTRL key, the SHIFT key and the letter T. Then release all the keys.  

3. Your address will type out into the notepad program.  



 

Creating a Shortkey Macro 
 

This topic shows how to create a macro assigned to a Shortkey. When completed the macro will play back your email 
address.  

  

Defining Shortkeys Default Settings 
First, we need to define the default settings that will apply to all Shortkeys that you may later create.  

  

1. From the Macro Express Pro - Explorer menu click on Options | Preferences to load the Preferences window.  

2. Click on Activations and then the ShortKeys  tab to display the Shortkeys options.   

3. Select the Use Prefix Keys option and enter ## in the Prefix Keys entry box.  

4. Click the OK button to return to the Macro Explorer.  

  

 Note:  This setting requires that ## be pressed before typing any Shortkey defined or the macro will not play back.  

  

  

Setting up the Macro and Assigning the Shortkey 
1. From the Macro Express Explorer menu click on the New Macro icon to open the  Create New Macro window. 

2. Select ShortKey from the Initial Activation list.  

3. Type "email" (without the quotes) into the Original ShortKey entry space.  

4. In the Nickname box, enter My Email Address and click OK to open the Script Editor. 

  

  

Creating the Macro 
1. In the Script Editor click on the Scope tab and make sure Global is selected from the drop down menu.  

2. Now click on the Script tab to start writing the macro.  

3. Scroll down the list of commands and click on the Keyboard command to expand this listing.  

4. Double click on the Text Type command found in this group to activate the Text Type window.  

5. Type your email address in the Keystrokes field. 

6. If you want to have the macro paste the text into your application via the Windows clipboard, select the Use 
Clipboard to Paste Text option from the drop down menu. Otherwise the text is inserted into your application 

using the Simulate Keystrokes default option, which types out the text letter by letter.  

7. Press the OK button to save the entry and return to  the Script Editor.  

  

Note:  A new entry should now appear under the section called Macro Script. This entry should read Text Type: followed 

by the email address that you entered. If y ou made a mistake entering your email address, you can double click on this 

entry and edit the address in the Text Type window.  

  

8. From the Script Editor, click on the Save and Close button to save the macro and close the Script Editor. 

9. Open the Macro Explorer to see the newly defined macro, "My Email Address", added to the list of available 

macros. 

 

  

Playing Back the Macro  
1. To test the macro, run the notepad program. (To run notepad, click on "Start | Run" from the bottom left of the 

computer screen, enter "notepad" and click the OK button.)  

2. Once notepad is running, type the following: ##email  

3. Watch as your email address is typed into the notepad program.  

  

  

  

  

  

  

  



 

Creating a Scheduled Macro 
 

This page demonstrates creating a Scheduled Macro, one that plays back on a schedule. To start, click on the New Macro 
icon from the Macro Express Pro - Explorer window to open the Create New Macro window. 

  

  

Setting the Schedule  
1. Select Schedule from the Initial Activation list to dis play the scheduling options. 

2. For this example select the "When a Specified Time has Elapsed" from the Run the Macro drop down menu.  

3. In the Schedule tab, select 0 hours, 1 minutes and 0 seconds. 

4. Click on the Range tab. 

5. Select the Play Macro Indefinitely option from the drop down list.  

6. You should be able to leave the "Start calculating the next runtime at" fields alone. Check to make sure the time 

listed is not later than the time on the computer clock. Make sure that the date displays today's  date. 

7. Leave the "Run the macro between these hours of the day" option not checked.  

8. Leave every day of the week selected. 

9. Enter "Date and Time" as the macro nickname. 

10. Click the OK button to open the Script Editor. 

  

 Based on the schedule just set, the macro will run every minute.  

  

  

Setting the Program Scope 
We'll create this macro to only play back in the Notepad window and only if it is already running.  

  

1. Click on the Scope tab and select Window/Program Specific. 

2. Click on the Add Window button to open the Select Window dialog.  

3. Click on the Visible tab and enter "notepad" (without the quotes) in the Window Title edit field.  

4. Select Partial Match from the drop down list.  

5. Leave the option "A window with this t itle must be on top" unchecked.  

6. Click OK to save the Scope information. 

  

  

Building the Macro 
  

1. Click on the Script tab to start writing the macro.  

2. To begin, expand the Windows/Programs category of commands.   

3. Double click on the Window Activate command.  

4. Enter "notepad" (without the quotes) for the Window Title and click on the OK button.  

5. Select Partial Match from the drop down list and click OK to save the information and insert into the macro script.  

6. Expand the Variables category of commands.   

7. Double click on Date/Time to open the Date/Time window.  

8. In the Date/Time tab, make sure the "Set it to the current date/time" option is selected.  

9. Click on the Operation tab. 

10. Select the "Type the Date/Time stamp out" option.  

11. Enter "ddMMMyyyy h:mm:ss" (without the quotes) in the Choose a Date/Time Format edit box.  

12. Click OK to save the changes. 

  

Note:  There should be two lines of script displayed in the Script Editor. Double click on either of these entries to make 
changes.    

  

13. From the Script Editor, click on the Save and Close button.  

14. Open the Macro Explorer window to see your newly defined macro, Date and Time, added to the list of available 

macros. 

  

  

Playing back the Macro  
As long as Macro Express is running, a timed macro should be ready to execute. However, in this example the timed 



macro will only execute if Notepad is running.   

  

1. To test the macro, run the Notepad program. (To run Notepad, click on Start | Run from the bo ttom left of the 

computer screen, enter "notepad" and click the OK button.)  

2. Once Notepad is running, just wait.  

3. The date and time is typed into Notepad every minute.  

  

  

Disabling the Macro  
After verifying that the macro works, either delete or disable this macro since you won't want this Scheduled Macro to 
continue executing every minute indefinitely! To delete the macro, highlight the macro in the Macro Explorer list and 

choose "Macros | Remove Macro" from the menu.  

  

To keep this example around, but not to play back every minute, right mouse click on the macro. Left click on Disable to 
disable the macro. The macro is now displayed in the Explorer window with italicized red font and possibl y a line drawn 

through it, depending on Preference settings. This quickly alerts that the macro is disabled and will not play back until it 
is enabled. 

  



 

Capture a Macro using the Capture Icon 
 

This example shows how to record a macro. We'll capture the macro in the Windows Paint program. To start the 
Windows Paint program, click on Start | Run from the bottom left of the computer screen, enter "mspaint" and click the 

OK button. Once Paint is running, we want to switch directly to Macro Express. If running Macro Express in the system 

tray, left click on the Macro Express icon in the system tray; otherwise click on Macro Express in the taskbar.  

  

  

Defining the Macro 
1. From the Macro Express Pro - Explorer window click on the Capture icon on the sidebar to open the Create New 

Macro window.  

2. HotKey should be the default Initial Activation and the blinking cursor should be in the HotKey edit box. If the 

cursor is not in the edit box, click on the edit box with the mouse to place it there.  

3. Next, hold down the SHIFT key, the CTRL key and the U key all at the same time. Release the keys to display 
CTRL+SHIFT+U in the edit box. This is the hot key assigned to the macro we record.  

4. Make sure the box next to Wait for the Hot Key to be Released Before Activation is checked. 

5. Enter My Paint Drawing as the nickname and click OK.  

  

  

Defining the Capture Options 
The Capture a Macro window opens so that the default capture options may be modified before capturing the macro. The 

default settings are defined from the Macro Explorer window in Options | Preferences | General | Capture. Let's adjust 
the capture settings for this macro capture.  

  

Set Scope 

The first thing to do is to set the scope so that the macro only starts in the MS Paint program.  

  

1. Click on the Set Scope button to open the Set Scope window. 

2. Change the scope to Window/Program Specific if not already selected. 

3. Click on the Add Program button to open the Select a Program Window. 

4. Click on the Running Processes tab and highlight mspaint.exe. 

5. Make sure that the "This program must have a window on top" option is checked.  

6. Click OK and click OK again to save and return to the Capture a Macro window. 

  

Other Capture Options 

1. Check the Capture the Keystrokes option. 

2. Check the Capture Mouse option and select the Relative to Window option from the drop down menu.  

3. Make sure the Capture and Restore the Window Size option is checked. 

4. Only Capture the Mouse Clicks should not be checked. 

5. From the drop down menu select Capture the Macro Speed at Actual Speed . 

6. Choose "untitled - Paint" from the drop down list of the Begin Capture in Window section.  

  

  

Start Recording 
Now we are ready to record the mouse movements, clicks and keystrokes. 

  

1. Click on the Capture button. This closes the Capture a Macro window and opens the Paint window. 

2. At this point the macro is now recording. We'll just draw a simple face in Paint.  

3. Click on a color. 

4. Draw a circle and place two eyes, a nose and mouth within the circle.  

5. Terminate the capture by pressing the hot key we assigned to the capture - CTRL+SHIFT+U. 

6. A message appears indicating that the capture is complete.  

  

  

Play back the Macro 
1. Open the Paint window. If it is not already the active window, click on the Paint entry in the task bar.  

2. We need to start with a clean screen in Paint. So click on File | New in Paint and follow the prompts to have a 
fresh screen. 



3. Press the hot key CTRL+SHIFT+U to start the macro playback. 

  

The face just drawn will be redrawn complete with any hesitations made while capturing!  

  

  

  



 

Capture a Macro - System Hot Key 
 

Macro Express has eight hot keys automatically assigned as System Macros. One of these System Macros is called Start / 
Stop Capture and by default is defined as CTRL+ALT+SHIFT+X. Pressing CTRL+ALT+SHIFT+X starts the recording of a 

macro. Pressing it a second time stops the recording. The system macro hot key combination may be changed to another 

hot key combination not presently being used in Macro Express. 

  

Capture Settings  
Before recording any macros using the System Hot Key we first need to define the default capture settings.  

  

1. From the Macro Express Pro - Explorer click on Options | Preferences | General and select the Capture tab to 
display the Capture default settings. 

   

Note: These are the settings that are used when the System Start / Stop Capture Hot Key function is invoke d. These 

are also the default settings that appear when clicking on the Capture icon to start a macro recording.  

  

2. Set the Default Scope to Window/Program.  

3. Check the Capture Keystrokes option. 

4. Check the Capture Mouse option and select the Relative to Window option from the drop down menu.  

5. Make sure the Capture the Window Size option is checked. 

6. Check the "Capture the Macro Speed at" option and select Actual Speed from the drop down list. 

7. Check the Display a Prompt Before Capturing box to display a message indicating the capture is starting. 

8. Click OK to save the results. 

  

Capturing the Macro  
An important thing to remember when recording a macro is to make sure that the program to start recording in is active 
and on top. Our example recording uses the Windows Paint program. 

  

1. First run the Windows Paint program. To do so, click on Start | Run from the bottom left of the computer screen, 

enter "mspaint" and click the OK button.  

2. Once in the Paint program, press CTRL+ALT+SHIFT+X.  

3. A notice may appear warning about the use of the ALT key. Click OK.  

4. Next appears a notice that the macro is about to start recording. Click the OK button to start recording.  

  

The macro is now recording. Let's do something fairly simple in the Paint p rogram such as drawing a face.  

  

5. Click on a color. 

6. Draw a circle and place two eyes, a nose and mouth on it.  

7. When finished drawing, terminate the macro capture by pressing the same System Hot Key, 
CTRL+ALT+SHIFT+X.  

  

Macro Information 
The "Create New Macro" window opens for assigning a macro activation.  

  

1. Select HotKey as the Initial Activation if not already the default.  

2. Place the cursor in the hotkey edit window and press CTRL+SHIFT+S. 

3. Release the keys to display CTRL+SHIFT+S in the edit box and use as the macro activation hot key.  

4. Type My Paint Drawing #2 in the nickname field and press OK. 

5. Select Window/Program Specific from the Set Scope window. 

6. Click on the Add Program button to open the Select a Program Window. 

7. Click on the Running Processes tab and highlight mspaint.exe. 

8. Make sure that the "This program must have a window on top" option is checked.  

9. Click OK to finish the macro. 

  

Play back the macro 
1. Open the Paint window. If it is not already the active window, click on the Paint entry in the task bar.  

2. We need to start with a clean screen in Paint. So click on File | New in Paint and follow the prompts to have a 
fresh screen. 



3. Press the hot key CTRL+SHIFT+S to start the macro playback.  

  

The face just drawn will be redrawn complete with any hesitations made while capturing!  

  



 

Create Macro with Quick Wizard 
 

In this tutorial we'll demonstrate how to create a macro using the Quick Wizard. The Wizards will guide us step by step 
through the creation process. For this example we will create a reminder message to display on screen at the time we 

designate. 

  

1. From the Macro Express Pro - Explorer window click on the Quick Wizards icon to start the wizard.  

2. Select the Text Based Macros option and click on the Next button. 

3. Select the Create a Reminder option and click on the Next button. 

4. The next screen just points out a few possible uses for the reminders. Click Next to continue.  

5. In the Edit window enter the text. For this example, enter "This is a reminder to purchase Macro Express online 
at www.macros.com/orders.htm." Click on the Next button to contin ue. 

6. Select the Sound Beep notification option to also play a beep when the macro runs. 

7. Check the box next to Delete this macro after displaying the reminder. Once the macro has run, the macro is 

removed from the list of macros in the Macro Explorer a nd sent to the Macro Recycle Bin.  

8. Click Next to set up the schedule for the reminder message. 

9. From the drop down list, change the Macro Run option to Once.  

10. Change the Run At time to 15 minutes ahead of the current time.  

11. Make sure the date is set to today's date and click Next.  

12. Insert "My Reminder" in the Macro Nickname edit field (without the quotes) and click Finish to close the Wizard.  

  

Open the Macro Express Explorer window to see the new macro in the list of created macros. Wait the 15 minutes 

specified and the reminder message will pop up on the screen. 

  

Close the message and the macro is removed from the macro list in the Explorer window and sent to the Macro Recycle 

Bin. 

  

  

  

  

  

  

  

  



 

Create a Popup Menu 
This example demonstrates how to create a popup menu. Before creating a popup menu, you must already have some 
macros defined. Note:  If you have not done so, first create both a Hot Key macro and a Shortkey macro as described in 

the Creating a Hot Key and Shortkey tutorials. This example is based on the assumption that you have already created 

these macros.  

  

  

Initial setup of the menu 
1. From the Macro Express Pro - Explorer menu click on Macro | New Macro to open the Create New Macro window.  

2. Make sure that the Hot Key activation is selected and the cursor is in the hot key edit box.  

3. Hold down the ALT key, the SHIFT key and the Z key all at the same time and release them. ALT+SHIFT+Z 
should appear in the edit box. This is the hot key we will use fo r the popup macro.  

4. Enter My Menu as the macro nickname.  

5. Check the box next to build as a Popup macro and click OK to open the Menu Builder. 

  

  

The Menu Builder 
The Menu Builder contains two columns. The left hand column lists all macros available for use in the menu. The right 

hand column displays the macros that we assign to the menu.   

  

Adding Macros to the Menu 

For this example we will only include two macros in the menu. But in practice you can add many more. To build the 

menu, first highlight the My Address macro (the one we created earlier) and then click on the green Insert 

 button. Next highlight the My Email Address macro (created earlier) and click on the green Insert button. These 

two macros should now be displayed in the right hand column.  

  
Select Menu Style and Positioning 

Before saving the menu, click on the Miscellaneous tab. Make sure the Menu is Enabled button is checked. Select 
Nickname and Scope from the drop down menu as the Menu Style. Enter 100 in both the X and Y menu positioning 

fields. Check the box next to Place an icon in the System Tray option. 

  
Select an Icon to Display in System Tray 

Now let's select an icon to use with the menu. Right above the Menu tab and to the left of the Menu Nickname is an 

icon. Hovering the mouse cursor over the icon displays the text - Change Macro Icon. Click on this icon to open the 

Select an Icon window. Click on the Browse button to open a view of the Macro Express Pro folder.  

  

Double click on the Icons folder to display the folder contents. You will see a number of folders of icon sets as well as 

individual icons - .ico files. Click on the arrow01d.ico f ile (a yellow down arrow) and click on the Open button to 

return to the Select an Icon window. Highlight the icon and click OK. The icon in the Build a Menu window has been 
changed. This is the icon that will be displayed in the system tray.  

  

Click on Save and Close to save the menu. Return to the Macro Explorer window to see the newly defined popup macro, 

ALT+SHIFT+Z, added to the list of available macros.  

  

  

Testing the Popup Menu  
There are two methods for activating the menu we created. One is to pre ss the hot key we assigned or to left mouse 

click on the icon displaying in the system tray.  

  

Hot Key Activation 

Let's test out the popup menu and run the macros in Notepad. (To run notepad, click on Start | Run from the bottom 

left of the computer scree n, enter notepad and click the ok button.) Once notepad is running, hold down the 
ALT+SHIFT+Z keys. 

  



 
  

A menu like the one above should appear, listing the two macros previously defined. Either press the corresponding 
letter or number next to the macro or double click on the macro in the menu to run the selected macro i n notepad. 

  
System Tray Activation  

Another way to invoke the popup menu is to left click on the arrow01d.ico icon (yellow arrow pointing down) in the 
system tray. The "yellow arrow" icon should now be showing in your system tray, because of the settings we chose 

previously.  

  

  

Menu Styles 
The popup menu may be displayed in four different forms, including Nickname and Scope, which is what we are currently 

using.  

  

First Part of Macro 

Let's take a quick look at the other options for displaying the menu. Double click on the Popup Menu macro from the 

list of macros in the Macro Explorer to open the Menu Builder window. Click on the Miscellaneous tab. Select the First 

Part of Macro option from the Menu Style drop down list. Click on Menu | Save Menu to save the change. Left click 
on the "yellow arrow" icon in the system tray. The menu pops up, but this time, it lists the first part of the contents 

of each macro. 

  
Icon  

Close the popup menu and return to the Menu Builder. Click on the Miscellaneous tab and select the Icons Only 

option from the Menu Style drop down list. Next, choose the Horizontal option and enter 10 for Maximum Icons per 
Row. Click on Menu | Save Menu to save the change. Now click on the "yellow arrow" icon in the system tray. The 

menu displays, but this time, it shows a list of icons. Click on one of the icons in the menu to run the macro.  

  
Windows Default  

Return to the Menu Builder and click on the Miscellaneous tab. Select the Windows Default option from the Menu 
Style drop down list. Click on Menu | Save Menu to save the change. Now click on the "yellow arrow" icon in the 

system tray. The menu displays as shown below. 

  

 
  

Click on the macro you want in order to execute the macro. Windows also assigns underscores to each of the 

macros, where possible. So in the example above, pressing the M key activates the My Address macro. 

  

  



 

Tutorial - Macro Scopes 
 

Macro Scope 
The macro scope indicates under what conditions a macro should play back. Four categories are available. They are 

Global, Global Except, Window Specific and Program Specific.  

  

A. Global macros play back in all Windows programs. 

B. Global Except macros run in all Windows programs or windows except the application or window specified.  

C. Window Specific macros run only a window that has a matching Window Title as specified by the macro.  

D. Program Specific macros only play back in a selected program. 

  

Let's look at some real examples of how this all works. To illustrate the process, let's run two different programs for 

testing the macro and scope. Run Windows Notepad and Windows WordPad. To run Notepad, click on "Start | Run" from 
the bottom left of the computer screen, e nter "notepad" and click the OK button. To run WordPad, click on "Start | Run" 

from the bottom left of the computer screen, enter "wordpad" and click the OK button.  

  

Global Macro 
We have actually already created a couple of Global macros. If you have not created these macros, please refer to the 

Hot Key section for instructions on creating the CTRL+SHIFT+T macro. A global macro plays back in all Windows 
programs. 

  

To illustrate, bring Notepad to the foreground (click on it in the taskbar). Now press CTRL+ SHIFT+T to see the address 

typed into the program. Now bring WordPad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T to see 
the address typed into WordPad. 

  

Program Specific Macro 
We will first change the CTRL+SHIFT+T macro to become a Program Specific macro.  

  

1. Minimize Notepad and WordPad. 

2. With Macro Express Pro - Explorer the active window, highlight the CTRL+SHIFT+T macro (nickname of "My 

Address") from the Macro Explorer and click on the Edit Macro button to open the Script Editor.  

3. Click on the Scope tab from the Script Editor. 

4. From the Current Scope drop down menu, select Window/Program Specific. 

5. Click on the Add Program button to open the Select a Program window.  

   

Note:  The Select a Program window has two tabs, Start Menu and Running Processes. The Start Menu tab allows you to 

look through programs in your Start Menu to locate the .exe file. Or you can click on the Browse button to find th e file 

anywhere on your computer.  

  

6. For our example, click on the Running Processes tab to list all programs currently running on the computer.  

7. Make sure that the box next to "This program must have a window on top" is checked.  

8. Scroll through the list of programs running and find notepad.exe.  

9. Highlight it in the list and click on the OK button.   

10. To see what effect the changes have on the macro and bring Notepad to the foreground (click on it in the 

taskbar). Press CTRL+SHIFT+T to see the address typed into the program.  

11. Now bring WordPad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T. Nothing happens 
because the macro is set to only work in Notepad. 

  

Global Except 
The next step is to change the CTRL+SHIFT+T macro to become a Global Except macro.  

  

1. First minimize Notepad and WordPad.  

2. With Macro Express Pro - Explorer the active window, highlight the CTRL+SHIFT+T (nickname of "my address") 

macro from the Macro Explorer and click on the Edit Macro button to open the Script Editor.  

3. Click on the Scope tab. 

4. From the Current Scope drop down menu, select Global Except.  

  

We can now choose to have the macro work everywhere except a specific window or program th at we select. For this 

tutorial we will use the program option.  



  

5. Notepad.exe should be displayed as the program that will not allow the macro to work. If not, highlight any 

entries and click on the Remove button to delete them. With no programs or win dows selected click on the Add 
Programs button. From the Select a Program window click on the Running Processes tab to list all programs 

currently running on the computer. Make sure that the box next to "This program must have a window on top" is 

checked. Scroll through the list of programs running and find notepad.exe. Highlight it in the list and click on the 
OK button.   

6. To see what effect the changes have on the macro, bring Notepad to the foreground (click on it in the taskbar) 

and press CTRL+SHIFT+T. Nothing happens because the macro is defined to not work with Notepad.  

7. Now bring Wordpad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T to see the address typed 
into the program.  

8. Activate another program that accepts text inp ut such as an email program and press CTRL+SHIFT+T. The 

address types into the program. 

  

Window Specific Macro 
The last step is to change the CTRL+SHIFT+T macro to become a Window Specific macro. The macro only plays if a 
window with a specific title is open or on top. (A Window Title is the text that appears in the top caption bar of most 

windows). 

  

1. First minimize WordPad and Notepad.  

2. With Macro Express Pro - Explorer the active window, highlight the CTRL+SHIFT+T macro from the Macro 
Explorer and click on the Edit Macro button to open the Script Editor.  

3. Click on the Scope tab from the Script Editor. 

4. From the Current Scope drop down menu, select Windows/Program Specific.  

5. Highlight Notepad.exe listed in the edit field.  

6. Click on the Remove button to delete this entry.  

7. Click on the Add Window button to open the Select Window dialog.  

  

Note: The Select Window dialog contains two tabs, Visible and Hidden. You may select a window that is visible or a 
hidden program window that is never displayed. For this tutorial we will use a Visible window.  

  

8. Highlight Untitled - Notepad. 

9. Check the box next to "A window with this title must be on top".  

10. Click OK to save. 

11. To see what effect these changes have on the macro, bring Notepad to the front of the screen (click on it in the 
taskbar. Press CTRL+SHIFT+T to see the address typed into the program.  

12. Now bring WordPad to the front of the screen (click on it in the taskbar). Press CTRL+SHIFT+T. Nothing 

happens because CTRL+SHIFT+T is set to only work in an Untitled - Notepad window. 



 

Copy and Paste Between Two Applications 
Below is a simple example of how to set up a copy and paste routine between two applications. Use this as a guideline 
for creating routines between other applications.  

  

You might be tempted to try and use the ALT+TAB key to switch between programs. T his is actually not always reliable 

and in fact will not even work via Macro Express on some computers due to the low level nature of this key command. 
The solution is to use the ACTIVATE command.  

  

  

Setting up the Macro 
From the Macro Express Pro - Explorer menu click on Macro | New Macro to open a Create New Macro window. The 
Initial Activation should default to HotKey and the blinking cursor should be in the HotKey edit box. If the cursor is not in  

the edit box, click on the edit box with the mouse to place it there. Next, hold down the CTRL key, the SHIFT key and the 
P key all at the same time and then release them. CTRL+SHIFT+P should appear in the edit box. This is the hot key used 

to activate the macro.  

  

Enter Copy and Paste in the Nickname field and click OK to open the Script Editor. Next click on the Scope tab and make 
sure that the macro scope is set to global. Then click on the Script tab to start building the macro.  

  

  

Building the Macro in the Script Editor 
1) Scroll through the list of comm and categories and click on Windows/Programs to expand the list. Double click on the 

Window Activate command. In the Activate Window field, enter "notepad" (without the quotes) as the Window title. Make 

sure the Partial Match option is selected. Click on the OK button to save the entry. This first command instructs the 
macro to bring notepad to the front and be ready to receive keystrokes.  

  

2) The object of the macro is to repetitively copy one line at a time over to WordPad. The first step in this proces s would 

be to highlight a single line of text. This can be done by using Shift+End. To do this scroll through the list of command 
categories and click on Keyboard to expand the category. Double click on Text Type to open the Text Type window. Click 

on Shift and then End in the list of options in the yellow area of this window to insert <SHIFT><END> into the 
Keystrokes edit field. Click OK to save the changes. 

  

3) The next step is to copy the highlighted text to the Windows Clipboard. Scroll through the lis t of command categories 

and click on Clipboard to expand the category. Double click on the Clipboard Copy command to insert into the script.  

  

4) Before pasting the text into WordPad, let's first move the cursor to the next line in notepad so that the macr o is ready 
to copy the next line of text. To do this, scroll through the list of command categories and click on Keyboard to expand 

the category. Then double click on Text Type to open the Text Type window. Click on Home and then Arrow Down in the 
list of options in the yellow area of this window to insert <HOME><ARROW DOWN> into the Keystrokes edit field. Click 

OK to save the changes. 

  

5) To activate WordPad, follow the same process as before by scrolling through the list of command categories and 
clicking on Windows/Programs to expand the list. Double click on the Window Activate command. In the Activate Window 

field, enter "wordpad" (w ithout the quotes) as the Window title.  Make sure the Partial Match option is selected. Click on 

the OK button to save the entry. This command activates WordPad and allows text entry into this window.  

  

6) The next step of the macro is to paste the text f rom the clipboard into WordPad. To do this scroll through the list of 

command categories and click on Clipboard to expand the category. Double click on the Clipboard Paste command to 

insert into the script.  

  

7) Now place an <ENTER> in the macro to move th e cursor to a new line in WordPad. To do this, scroll through the list 

of command categories and click on Keyboard to expand the category. Double click on Text Type to open the Text Type 

window. Click on Enter in the list of options in the yellow area of t his window to insert <ENTER> into the Keystrokes edit 
field. Click OK to save the changes.  

  

8) There are two final issues that need to be addressed. The first is to place the macro in a loop so that it copies multiple  

lines. In this example we will set t he macro to copy the first 5 lines in notepad over to WordPad. Highlight the first line of 
the macro script - Activate Window: "notepad". Scroll through the list of command categories and click on Repeat to 

expand the category. Single click on the Repeat Start option and then click on the Insert Command Before Selected arrow 
- the top green arrow of the three insert arrows to open the Repeat Options window. Make sure the Repeat Start option 



is selected and enter 5 in the Number of Times to Repeat entry fiel d. Click OK to save the change and insert the Repeat 

command as the first line of the macro.  

  

9) Single click on the End Repeat command and then click on the Add Command to End of Script button - the bottom of 
the three Insert buttons to insert an End Rep eat command as the last command of the macro script.  

  

10) The last step is to address a possible timing issue. It's possible for Macro Express to send the Clipboard Paste 

command before WordPad has fully activated. So what we need to do is insert a short delay right after activating either 
window. To do this, scroll through the list of command categories and click on Timing to expand the list. Then double 

click on Delay to open the Set Delay window. Select the Delay in Seconds option and enter .5 (one half second). Click OK 
to save the change. 

  

Find the delay command in the script and highlight it. Then click on the Duplicate button  to make a copy of this 
command. The Duplicate button is the bottom of the three buttons to the right of the Macro Script. You should now have 

two Delay commands listed in the script. Highlight one of the Delay commands and click on the Up or Down arrow on the 

right side of the Macro Script. Move the delay command so that it is positioned belo w the Activate Window: "notepad" 
command and above the Text Type:<SHIFT><END> command. Go back and highlight the other Delay command and 

move it so that it is positioned below the Activate Window: "wordpad" command and above the Clipboard Paste 
command. 

  

  

Macro Script 
The macro script should look like what is displayed below. If the macro does not look like this, arrange the commands so 
that they are in the following order.  

  

Repeat Start (Repeat 5 times) 

  Window Activate: notepad 

  Delay: 0.5 seconds 

  Text Type (Simulate Keystrokes): <SHIFT><END>  

  Clipboard Copy 

  Text Type (Simulate Keystrokes): <HOME><ARROW DOWN> 

  Window Activate: wordpad 

  Delay: 0.5 seconds 

  Clipboard Paste 

  Text Type (Simulate Keystrokes): <ENTER> 

End Repeat 

  

  

Testing the Macro 
Click on File | Save to save the macro. Next run the notepad and WordPad applications. (To run notepad, click on Start | 

Run from the bottom left of the computer screen, enter notepad and click the OK button. To run WordPad, click on Star t 
| Run from the bottom left of the computer screen, enter wordpad and click the OK button.)  

  

Enter five lines of text into notepad or copy the first five lines of the macro script displayed above and paste them into 

notepad. Make sure you don't have any blank lines between the lines of text. Next, place the mouse cursor at the 
beginning of the first line of text in notepad. Then press CTRL + Shift + P to start the macro and watch it switch between 

both programs, copying each line from notepad and pasting into WordPad. 

  



 

Using Controls 
 

This example provides a simple demonstration of using the Window Controls with the Windows calculator. To run the 
Windows calculator click on Start | Run from the bottom left of the computer screen, enter calc and click th e OK button. 

Leave the program running and return to Macro Express. 

  

  

Select a Macro Activation  
For this example we will create a hot key activated macro.  

  

1. From the Macro Express Pro - Explorer click on the New Macro icon to open the Create New Macro window.  

2. HotKey should be the default Initial Activation and the blinking cursor should be in the HotKey edit box. If the 
cursor is not in the edit box, click on the edit box with the mouse to place it there.  

3. Press the F3 key and then release it. F3 should appear in the edit box.  

4. Enter "Clear Calculator" (without the quotes) in the Macro Nickname edit field.  

5. Click OK to save the changes and open the Script Editor. 

  

  

Set the Macro Scope 
1. With the Script Editor open, click on the Scope tab. 

2. Set the Current Scope to Global. 

  

  

Naming the Variable 
1. Click on the Variables tab.  

2. Click on the Add button to open the Variable Properties window.  

3. Type calc into the Variable Name field to assign the variable name as "calc".  

4. Select Control Variables as the Variable Type. 

5. When finished the screen should look like the example below. 

6. Click OK to save. 

  

 
  

Writing the Macro 
Setting the Control Variable 

1. Click on the Script tab. 

2. Expand the Window Controls category of commands. 

3. Double click on the Get Control command to open the Get Control window. 

4. Place a check in the box next to Hide Macro Express.  

5. Click on the Store the Control In field to display a Variables button.  

6. Click on the Variables button and expand the Control Variables list.  

7. Highlight the "calc" variable and click OK to save. 

8. Click on the Launch Utility button to open the Capture Window Control window.  

9. If the Calculator program is not visible on the screen open the Calc window.  

10. Click on the blue X crosshairs on the Capture Window Control window and drag it over top of  the "C" button on 



the calculator.  

11. Release the mouse button to insert the control information into the Control Details panel.  

12. Click the save button to save the information and return to the Get Control Window.  

  

 
  

This window now displays the information stored to the "calc" variable as shown above.  

Click OK to save this command and return to the Script Editor.  

  

Clicking on the Control 

1. Expand the Mouse category of commands. 

2. Double click on the Mouse Click on Control command to open the Mouse Click on Control window. 

3. In this window, the Command listed will be Mouse Click on Control.  

4. Select Single Click which should be the default option. 

5. Place the cursor in the Control edit box to display the Variables button.  

6. Click on the Variables button and expand the Control Variables list. 

7. Highlight the "calc" variable and click OK to save. 

8. Make sure the button selected is the Left Button.  

9. Click on the Advanced tab and ensure that Center is selected as the Click location. 

10. Click OK to save. 

  

  

Macro Script 
The script instructs the macro to perform a single left mouse click on the "calc" variable, which is defined as the "C" 

button on the Calculator. The script should look like the following:  

  

Get Control 
Mouse Click on Control %calc% 

 

Click on Save and Close to save the macro. Open the Macro Explorer to see the F3 macro with a nickname of Clear 

Calculator listed as an available macro. 

  

  



Playing back the Macro 
To test the macro, first run the calculator program. (If the program is closed, click on Start | Run from the bottom left of 
the computer screen, enter calc and click the OK button.) Enter some numbers into the calculator. With numbers 

displayed in the Calculator edit box, press the F3 button. This simulates clicking on the C button of the calculator and 
clears the display.  



 

Using Text String Variables 
 

Below is an example of using Text String Variables. There are hundreds, even thousands of uses for Text String 
Variables. This example provides an idea of how they can be used and manipulated.  

   

This macro, when completed, fixes typing transposition errors such as "adn" or "teh" instead of "and" or "the". Just place 

the cursor between the two transposed l etters and press the assigned hot key to correct the typing error.  

  

 

  

Setting up the Macro 
To get started, open the Macro Express Pro - Explorer and click on Macro | New Macro to open the Create New Macro 

window. HotKey should already be selected as the Initial Activation and the blinking cursor should be in the HotKey edit 
box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.  

   

Next, hold down the F4 key and then release it. F4 should appear in the edit box. This is the hot key we will define for 

the macro. In the Macro Nickname field enter "Fix Transposed Letters" (without the quotes). Click on the OK button to 
open the Script Editor. In the Script Editor click on the Scope tab and make sure that the macro scope is set to global. 

Click on the Script tab to start building the macro.  

  

   

Building the Macro in the Script Editor 
1) Scroll through the list of command categories and click on Macro Control to expand the list. Double click on the 

Comment command. Type "Place cursor between the transposed letters" (without the quotes) in the Comments Text edit 
field and click OK to save the entry. The text is displayed in bold blue font in the Script Editor. The Comment line does 

not do anything in the script. It is just a reminder for later of how to use the macro.  

   

2) The next step is to highlight the two letters t hat are reversed. Use the Text Type command to do this. Scroll through 
the list of command categories and click on Keyboard to expand the category. Then double click on Text Type to open 

the Text Type window.  

   

Click on Arrow Left from the list of option s in the yellow area of this window. This moves the text cursor one character to 
the left. Then click on Shift Down, Arrow Right, Arrow Right and Shift Up. The entire entry should look like the 

following:  <ARROW LEFT><SHIFTD><ARROW RIGHT><ARROW RIGHT><SHIFTU>. This step highlights the two 
transposed characters. 

   

Click OK to save and return to the Script Editor.  

   

3) This next step cuts the highlighted text and copies it to the clipboard. Scroll through the list of command categories 

and click on Clipboard to expand the category. Double click on Clipboard Cut to insert the clipboard cut command as the 
next item in the script.  

   

4) Now save the clipboard contents to a text string variable. Scroll through the list of command categories and click on 

Variables to expand the category. Then double click on Variable Set String to open the Variable Set String window. Select 
the Set Value from Clipboard option from the drop down menu. Enter %T[1]% in the Destination Variable field and click 

OK to save.  

   

5) The next couple of steps reverse the order of the two transposed letters copied to the clipboard. Scroll through the list 
of command categories and click on Variables to expand the category. Double click on Variable Modify String to open the 

Variable Modify String window. Select Copy Part of Text from the drop down list to copy the first letter of the variable 
T[1] and save it to variable T[2].  

   

Enter %T[2]% in the Text Variable field and enter %T[1]% the Variable to copy from field. Enter the number "1" 

(without the quotations) in the Starting Position field. In the Number of Characters to Copy field enter the number "1" 
(without the quotations). Click OK to save.  

   

6) This step copies the second letter of variable T[1] and saves it to variable T[3]. Scr oll through the list of command 

categories and click on Variables to expand the category. Then double click on Variable Modify String to open the 

Variable Modify String window. Select the Copy Part of Text option from the drop down list.  

   



Enter %T[3]% i n the Text Variable field and enter %T[1]% in the Variable to copy from field. Enter the number "2" 

(without the quotations) in the Starting Position field.  In the Number of Characters to Copy field enter the number "1" 
(without the quotations). Click OK to save.  

  

7) This last step plays back the corrected text.  Scroll through the list of command categories and click on Keyboard to 

expand the category. Then double click on Text Type to open the Text Type window.  

   

In the Keystrokes edit field, type the following: %T[3]%%T[2]%. This types out the second letter of the transposed text 
first, reversing the order and correcting the typing error. Click OK to save and return to the Script Editor.  

   

  

Macro Script 
The macro script should look like what is displayed below. If the macro doesn't look like this, arrange the commands so 

that they are in the following order.  

 

// Place cursor between transposed letters.  

Text Type (Simulate Keystrokes): <ARROW LEFT><SHIFTD><ARROW RIGHT><ARROW RIGHT><SHIFTU> 

Clipboard Cut 

Variable Set String %T[1]% from the clipboard contents  

Variable Modify String %T[2]% to a substring in %T[1]% starting at 1 and 1 characters long  

Variable Modify String %T[3]% to a substring in %T[1]% starting at 2  and 1 characters long 

Text Type (Simulate Keystrokes): %T[3]%%T[2]%  

 

Click on Script | Save Macro to save the macro just created.  

  

  

Testing the macro 
To test the macro, run the notepad program. (To run notepad , click on "Start | Run" from the bottom left of the 

computer screen, enter "notepad" and click the OK button.) Type the following text into notepad - Tihs is a tset. (Include 
the typing errors.)  

   

Insert the cursor between the "i" and "h" in the word "T ihs". Press the F4 key to play back the macro. The letters are 

reversed to correct the spelling to "This". Try the same thing with the misspelled word "tset".  

  

  

Note:  If assigning original names to variables, rather than using T[1], D[1], etc., then the following characters are not 
allowed in the variable name:  [ ] < > , . - + = \  | / * %  

  



 

Advanced - Using Integer Variables 
 

The object of the completed macro is to generate three random numbers from 1 to 100 and display the results. This 
macro requires using the Integer Variables as well as Arrays. 

  

  

Setting up the Macro 
From the Macro Express Pro - Explorer click on the New Macro icon to open the Create New Macro window. The Initial 

Activation should default to HotKey and the blinking cursor should be in the HotKey edit box. If the cursor is not in the 

edit box, click on the edit box with the mouse to place it there. Next, hold down the CTRL key, the SHIFT key and the R 
key all at the same time and release them. CTRL+SHIFT+R should appear in the edit box. This is the hot key used to 

activate the macro. 

  

Enter "Generate Random Numbers" in the Nickname field and click OK to open the Script Editor. Next click on the Scope 
tab and make sure that the macro scope is set to global. Then click on the Script tab to start building the macro.  

  

  

Building the Macro in the Script Editor 
1) Scroll through the list of commands and expand the Variables category. Double click on the Variable Set Integer 

command to open the window of the same name.  

2) From the drop down list select the Set to a Random Value option.  

  

Creating the variable and array 

a) Place the cursor in the Destination Variable field to display the Variables button to the right of the field.  

b) Click on the Variables button to open the Insert Variable window.  

c) Click on the Add button to open the Variable Properties window. 

d) Enter "Random" in the Variable Name field. 

e) From the drop down Variable Type list select Integer Variables. 

f) Check the box next to Create as an Array. 

g) Enter 3 (three) in the Elements field and click OK to return to the Insert Variable window.  

h) Expand the list of Integer variables (click on the +) to see the Random variable created.  

i) Highlight the Random variable to see Random[ ] displayed in the Variable Name field.  

j) Insert the number 1 (one) between the brackets so it displays as Random[ 1].  

k) Click OK to return to the Variable Set Integer command.  

  

3) The Destination Variable field should now display %Random[1]% as the variable.  

4) Enter the number 1 (one) in the Minimum Value field.  

5) Enter the number 100 (one hundred) in the Maximum Value field. 

6) Click OK to save the command and place it in the Script Editor. 

  

Generating the Random Numbers 
7) In the Script Editor highlight the Variable Set Integer command shown in the script and click on the Duplicate button 

 twice (on the right hand side of the script) so that you should now see three identical lines in the script.  

8) Double click on the second line in the script to open the Variable Set Integer command.  

9) Edit the Variable name by replacing the 1 (one) in brackets with a 2 (two). It should now display as %Random[2]%.  

10) Click OK to save and return to the Script Editor.  

11) Double click on the third line in the script to open the Variable Set Integer command.  

12) Edit the Variable name by replacing the 1 (one) in brackets with a 3 (three). It should now display as 
%Random[3]%.  

13) Click OK to save and return to the Script Editor.  

  

Have the macro display the results 
These next steps set up the display of the three random num bers in a text box. After completing lines 14 through 27, the 

Text Box Display command window should look like the image below. 

  

14) Scroll through the list of commands and expand the Dialogs category. Double click on the Text Box Display command 
to open the window of the same name.  

15) Insert "Display random numbers" in the Header field.  



16) Place the cursor in the Text Box field and the Variables button will appear to the right of the field.  

17) Click on the Variables button and expand the Integer Variab les type.  

18) Select the Random variable to place Random[ ] in the Variable Name field. 

19) Insert 1 (one) between the brackets so that it reads as Random[1] and click OK.  

20) This places %Random[1]% in the Text Box field.  

21) Copy the text %Random[1]% t o the clipboard. Highlight the text and press Ctrl + C to copy to the clipboard.  

22) Move the cursor to the second line (Right Arrow and the Enter key).  

23) Press Ctrl + V to paste the text into the second line.  

24) Move the cursor to the third line and pr ess Ctrl + V to paste again. 

25) You should now have three identical lines of %Random[1]%.  

26) In the second line, replace the 1 (one) with 2 (two) so that it reads %Random[2]%.  

27) In the third line, replace the 1 (one) with 3 (three) so that it reads %Ra ndom[3]%.  

28) Click on the OK button to save and return to the Script Editor.  

  

 
  

In the Script Editor, click on Script | Save Macro to save the macro just created.  

  

  

Macro Script 
The macro script should look like what is displayed below. If the macro does not look like this, arrange the commands so 

that they are in the following order.  

 



Variable Set Integer %Random[1]% to a random value between 1 and 100  
Variable Set Integer %Random[2]% to a random value between 1 and 100  

Variable Set Integer %Random[3]% to a random value between 1 and 100  

Text Box Display: Three Random Numbers 

  

  

Testing the Macro 
Press Ctrl + Shift + R to run the macro. A text box opens and displays three random numbers between 1 and 100.  

  

  

Note:  If assigning original names to variables, rather than using T[1], D[1], etc., then the following characters are not 

allowed in the variable name:  [ ] < > , . - + = \  | / * %  



 

Advanced - ASCII Text File Process 
 

This sample tutorial reads the contents of  a text file in .csv format and inserts the data into another application. 
Formatting the text to one of the ASCII formats (comma delimited, tab delimited or ASCII delimited) is a quicker and 

more reliable way to transfer data than the copy and paste routine described in a previous tutorial. The macro reads 

directly from the file and inputs the results directly into the receiving application. No need to switch back and forth 
between applications - no copying from one program and pasting to another.  

   

  

Creating a .csv file   
The first step is to create a .csv file with data for the macro to read.  

  

1. Copy the zip code data shown below to the clipboard. (Highlight the text in the Zip Code Data box and press Ctrl 

+ c.)  

2. Open the notepad program. (To run notepad, click on Start | Run from the bottom left of the computer screen, 
enter notepad and click the OK button.)  

3. Place the cursor in the notepad program and press Ctrl + v to paste the text into notepad.  

4. Click on File | Save As and make note or remember the location of where the file is about to be saved.  

5. In the Name field remove .txt and type UtahZips.csv.  

6. Click on the Save button to save the file.  

 

Zip Code Data 

84022,UT,DUGWAY,TOOELE,435,UTC -7:00,Y  

84023,UT,DUTCH JOHN,DAGGETT,435,UTC -7:00,Y  
84024,UT,ECHO,SUMMIT,435,UTC -7:00,Y  

84025,UT,FARMINGTON,DAVIS,801,UTC -7:00,Y  
84026,UT,FORT DUCHESNE,UINTAH,435,UTC -7:00,Y  

84027,UT,FRUITLAND,DUCHESNE,435,UTC -7:00,Y  

84028,UT,GARDEN CITY,RICH,435,UTC -7:00,Y  
84029,UT,GRANTSVILLE,TOOELE,435,UTC -7:00,Y  

84031,UT,HANNA,DUCHESNE,435,UTC -7:00,Y  
84032,UT,HEBER CITY,WASATCH,435,UTC -7:00,Y  

84033,UT,HENEFER,SUMMIT,435,UTC -7:00,Y  

84034,UT,IBAPAH,TOOELE,435,UTC -7:00,Y  

  

 

Setting up the Macro 
From the Macro Express Pro - Explorer click on the New Macro icon to open the Create New Macro window. The Initial 

Activation should default to HotKey and the blinking cursor should be in the HotKey edit box. If the cursor is not in the 
edit box, click on the edit box w ith the mouse to place it there. Next, hold down the CTRL key, the SHIFT key and the Z 

key all at the same time and then release them. CTRL+SHIFT+Z should appear in the edit box. This is the hot key used 
to activate the macro.  

  

Enter "Process Zip Code Data" in the Nickname field and click OK to open the Script Editor. Next click on the Scope tab 

and make sure that the macro scope is set to global. Then click on the Script tab to start building the macro.  

  

  

Building the Macro 



Process the ASCII Text File 

1. Scroll through the list of commands and expand the Files/Folders category. Double click on the ASCII File Begin 

Process command to open the window of the same name. 

2. Change the File Format option to Comma Delimited Text (.csv) from the drop down list.  

3. Click on the Browse button found below the File Name field and navigate to the location of the saved .csv file.  

4. Highlight the file and click on the Open button to place the name of the file and file path into the Filename edit 
box. 

5. Leave the Begin Processing on Record: field set to 1 in order to start processing the first line of the text file.  

6. Make sure the Process All Records option is selected. 

7. Place the cursor in the box next to Variable array to receive result and then click on the Varia bles button to open 

the Insert Variable window.  

8. Click on the + sign next to Type: Text Variables to expand the category.  

9. Click on the T to place a letter T in the Variable Name field.  

10. Click OK to save and return to the ASCII Begin File Process window. 

11. Leave the Starting Index set to 1.  

12. Click OK to save and return to the Script Editor. 

  

Note:  The T variable is an array that by default allows up to 99 variables - T[1], T[2] and so on up to T[99]. We could 

also have named our own variable and created the array by clicking on the Add button in the Insert Variable window. 
This process is described in the Advanced - Using Integer Variables tutorial.  

  

  

Insert the text into another application 

1. Scroll through the list of commands and expand th e Keyboard category. Double click on the Text Type command 

to open a window of the same name.  

2. Click on the Variables button at the bottom of the window to open the Insert Variable command.  

3. Click on the + sign next to Type: Text Variables to expand this category.  

4. Click on the T to place T[ ]in the Variable Name field.  

5. Enter the number 1 between the brackets so that it looks like T[1].  

6. Click OK to save and return to the Text Type window. 

7. Highlight the %T[1]% found in the Text Type window and press Ctrl c to copy to the clipboard.  

8. Press Enter to move the cursor to the line below the %T[1] found on the first line and press Ctrl v to paste.  

9. %T[1]% should now be displayed on two l ines. 

10. Move to line 3 and paste again.  

11. Repeat the process so that %T[1]% is displayed seven times, each underneath the other.  

12. On the last line, press the Enter key twice to move the cursor two lines below the last line of text.  

13. Go to line 2 and change %T[1]% to %T[2]%.  

14. Go to line 2 and change %T[1]% to %T[3]% and so on.  

15. Click OK to save and return to the Script Editor. 

  

 
  

The window should look like the above when finished, other than the locati on of the UtahZips.csv file.  



  

End Process ASCII Text File 

1. Scroll through the list of commands and expand the Files/Folders category. Double click on the ASCII File End 

Process command to insert the command at the end of the script.  

2. Click on Script | Save Macro to save the macro just created. 

  

  

Macro Script 
The macro should look like the following in the Script Editor. If the macro doesn't look like the script shown below, 

arrange the commands so that they are in the following order. The file path in the first command most likely will be 
different, based on w here you saved the UtahZips.csv file. 

 

ASCII File Begin Process: C:\ Insight Software\UtahZips.csv 
  Text Type (Simulate Keystrokes): %T[1]%  

  %T[2]%  

  %T[4]%  

  %T[5]%  

  %T[6]%  

  %T[7]%  

   
   

ASCII File End Process 

 

 

  

Playing Back the Macro 
Start the WordPad program. To run WordPad, click on Start | Run from the bottom left of the computer screen, enter 

wordpad and click the OK button. Make sure the text cursor is in the WordPad program and then press CTRL+SHIFT+Z 
to play back the macro.  

  

The data is inserted in a vertical format as shown below.  

 

84022 

UT 

DUGWAY 

TOOELE 

435 

UTC -7:00 

Y 

  

  

84023 

UT 

DUTCH JOHN 

DAGGETT 

435 

UTC -7:00 

Y 

 

Note:  This is a simple example of what can be done using the Process an ASCII Text File command. When entering the 
data into a database, choose which variables to insert and in what order, or add Tabs to move from field to field, etc. 

Create macros to update the record in the database, wait for a fresh screen, insert the second line of the text file into the 



database, and so on. 

  

  

  

  



 

Macro Activation 
 

There are numerous mechanisms available to activate or run a macro. These options are listed below. 

  

Hot Key 
A hot key is a key combination such as CTRL+ALT+A, CTRL+Right Mouse Click, etc. The macro activates when the keys 

are pressed and released.  

  

ShortKey 
A shortkey is a set of characters such as abc, myname, etc. The macro activates when the keys are typed into an 
application. 

  

Schedule 
The macro runs as a scheduled event. These events can be scheduled to play at startup of Macro Express, hourly, daily 

(choose any or all days of the week), weekly, monthly, one given time, every "x" minutes or after "x" minutes of 

inactivity.  

  

Window Title  

This option looks for a specific window title . The macro activates when the window either gains focus, loses focus, opens 
or closes, depending on the option selected.  

  

Mouse Event 
Use either the left, middle or right mouse buttons to activate the macro. Select an area of the screen to click on or 
designate a window part to click on, such as scroll bar, title bar, buttons, etc. to activate the macro.  

  

Control Event 
The Control Event option activates a macro when a specific Windows control or the window that contains the control 

gains focus. The control may be a window button, edit box or another identifiable portion of a window.  

  

Directory Modification 
Directory Modification looks for changes to files in a folder  or to the folder itself. The macro activates when a change is 

made to the specified folder or to a file within that folder. Some of the available options include the macro looking for 
changes to file size, attributes, write time, security descriptor or ch ecking if a file has been renamed or deleted. 

  

System Event 
Activate a macro when a System Event, such as a Windows message, resolution change or color change occurs. 

  

Process Event 
The Process Event activation method initiates a macro when a Process (an executable program or service) first starts or 
when it closes. 

  

TCP/IP 
This options looks for the TCP/IP stack to become available or unavailable. 

  

Clipboard Text 
Activate a macro based on the contents of the clipboard text. Select whether the clipboard does or does not match what 

was selected as the clipboard trigger. Or choose whether the clipboard contains or does not contain specific text.  

  

Floating Menu 
A Floating Menu is a menu of macros displayed as a floating toolbar and sits on top of other open applications. The 

floating menu either displays icons (representing the macros), the first part of the text of the macro or the macro 
nickname and scope. Clicking on one of the macros or typing a corresponding number or letter activates that macro from 

the floating menu.  

  

None 
None specifies that no activation is to be associated with the macro. In such cases, the macro may be included as a 

subroutine of another macro using the Macro Run command. Or the macro may be used in a popup menu of macros and 
no other macro activation is desired for the macro.  



  

Popup Menu of Macros 
A popup menu of macros is a list of macros displayed in a window. Clicking on one of the macros or typing a 

corresponding number or letter activates that macro from the popup menu. The popup menu itself is activated by either 

a hot key or by right clicking on a system tray icon. The popup menu may show icons (representing the macros), the first 
part of the text of the mac ro or the macro nickname and scope. 

  

Command Line Parameters 
Invoke a macro using a command line parameter. The specific command line parameters to invoke a macro are the /A 

and /MXE commands. Both the macexp.exe and the meproc.exe programs may be used. See the command line 

parameters help section for more detail.  

 

Via Windows Explorer 
Double clicking on a playable macro file (.MXE) from within Windows Explorer executes the macro. 

  

Run Macro Now 
Run a macro from the Macro Express Pro - Explorer by using the Run Macro Now option. Right click on the macro in the 
Macro Explorer and then left click on the Run Macro Now menu item. Or highlight the macro in the Macro Explorer list 

and click on the Run Now button.  

  

Windows API Calls 
This option is only intended for the programmer who wants to add macro functionality directly from their own programs. 

While the command line parameter options can be used via another program, the following method may be much quicker 
and remove the overhead of having to run an externa l program such as macexp.exe or meproc.exe. 

  

Instruct the Macro Express Player to directly execute a macro in the currently loaded macro file by specifying its 

nickname or instruct it to run a playable macro. The macro nickname is case sensitive. If the m acro is named QZStart 
then it must be typed as QZStart, not qzstart, QZSTART, Qzstart, QZstart, or QzStart. If more than one macro shares the 

same nickname, only the first one found in the macro file is activated.  

  

The following examples demonstrate the basic steps of how to activate a macro using Windows API messages and are 
presented in several different programming languages. These examples assume familiarity with basic Windows API 

commands and terminology. The process involves posting a series of messages directly to the Macro Express Player. 

  

These examples use the message WM_USER+20 to run a macro within the currently loaded macro file. To run a playable 
macro, change the messages in the examples from WM_USER+20 to WM_USER+21. 

  



Delphi Example 
 

var 

  i     : integer;  

  S    : string;  

  Hwnd  : THandle; 

begin 

  Hwnd := FindWindow('TMainWin', 'Macro Express Player'); 

  if(IsWindow(Hwnd)) then  

  begin 

    S := MacroName; 

  

    for i := 1 to length(S) do  

      PostMessage(Hwnd, WM_USER+20, ord(S[i]), 0); 

    PostMessage(Hwnd, WM_USER+20, 0, 0); 

  end 

  else 

    ShowMessage('Macro Express is not running'); 

end; 
 

 

C/C++/Visual C Example 
 

HWND hwnd = FindWindow("TMainWin", "Macro Express Player"); 

if( IsWindow(hwnd) ) {  

  for(int x = 0; x < strlen(s); x ++)  

    PostMessage(hwnd, WM_USER+20, s[i], 0); 

  PostMessage(hwnd, WM_USER+20, 0, 0); 

}  

else 

  MessageBox(GetForegroundWindow(), "Macro Express is not running", "Error", 0); 

 

 



VBA Example 
 

HWND hwnd = FindWindow("TMainWin", "Macro Express Player"); 

if( IsWindow(hwnd) ) {  

  for(int x = 0; x < strlen(s); x ++)  

    PostMessage(hwnd, WM_USER+20, s[i], 0); 

  PostMessage(hwnd, WM_USER+20, 0, 0); 

}  

else 

  MessageBox(GetForegroundWindow(), "Macro Express is not running", "Error", 0);  

  

   

Private Declare Function FindWindow _ 

  Lib "User32" Alias "FindWindowA" ( _ 

       ByVal lpClassName As String, _ 

       ByVal lpWindowName As String) As Long 

           

Private Declare Function PostMessage _ 

  Lib "User32" Alias "Porterage" ( _ 

       ByVal Wand As Long, _ 

       ByVal MSG As Long, _ 

       ByVal warm As Long, _ 

       ByVal Parma As Long) As Long 

  

Private Sub Unsacred) 

  'Runs a macro express macro 

  

  Const WM_USER = &H400 

  Const Command = WM_USER+20 

  Const Macroname = "Macroname" 

  

  Dim hwnd, I, Result As Long 

  

  hwnd = FindWindow("TMainWin", "Macro Express Player") 

  For I = 1 To Len(Macroname)  

    Result = PostMessage(hwnd, Command, Asc(Mid(Macroname, I, 1)), 0) 

  Next I  

  Result = PostMessage(hwnd, Command, 0, 0) 

End Sub 

 

   

 



 

Hot Keys 
 

A hot key is a combination of keys that, when pressed together, plays back a macro. Macro Express allows hot key 
combinations ranging from a single key up to four keys pressed simultaneously. 

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

To activate a new macro with a hot key, make sure the hot key choice is selected in the Create New Macro window. Place 

the cursor in the edit box and hold down the hot key combination desired. That combination is placed in the edit box. 
This is the hot key combination pressed to activate the macro. If not sure which combination to use, scroll through the 

list of keys and highlight the hot key combin ation. This action also inserts the hot key combination in the edit box.  

  

The selection is grayed out if the hot key combination is already in use. If the assigned macro has a Window Specific or 
Program Specific scope, the hot key combination may be used again. The hot key may not be used a second time if the 

macro scope is set to Global. 

  

Wait for the Hot Key to be Released before Activating 
This default setting requires that all keys in the hot key sequence be released in order for the macro to start pl aying. 

De-selecting this option allows the macro to start playing as soon as the hot key sequence is pressed. 

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later help more readily determine what the macro does.  

  

Build as a Popup Menu 
Select this option to open the Menu Builder window and create a popup menu.  

  

 

  

Hot Key Combinations 
Macro Express Pro supports 846 different hot key combinations. Below is a comprehensive list of available hot keys: 



 

Hot Key Combination Hot Key Combination Hot Key Combination Hot Key Combination 

Ctrl+A 

Ctrl+B 

Ctrl+C 

Ctrl+D 

Ctrl+E 

Ctrl+F 

Ctrl+G 

Ctrl+H 

Ctrl+I 

Ctrl+J 

Ctrl+K 

Ctrl+L 

Ctrl+M 

Ctrl+N 

Ctrl+O 

Ctrl+P 

Ctrl+Q 

Ctrl+R 

Ctrl+S 

Ctrl+T 

Ctrl+U 

Ctrl+V 

Ctrl+W 

Ctrl+X 

Ctrl+Y 

Ctrl+Z 

Ctrl+0 

Ctrl+1 

Ctrl+2 

Ctrl+3 

Ctrl+4 

Ctrl+5 

Ctrl+6 

Ctrl+7 

Ctrl+8 

Ctrl+9 

Ctrl+F1 

Ctrl+F2 

Ctrl+F3 

Ctrl+F4 

Ctrl+F5 

Ctrl+F6 

Ctrl+F7 

Ctrl+F8 

Ctrl+F9 

Ctrl+F10 

Ctrl+F11 

Ctrl+F12 

Alt+A 

Alt+B 

Alt+C 

Alt+D 

Alt+E 

Alt+Shift+U 

Alt+Shift+V 

Alt+Shift+W 

Alt+Shift+X 

Alt+Shift+Y 

Alt+Shift+Z 

Alt+Shift+0 

Alt+Shift+1 

Alt+Shift+2 

Alt+Shift+3 

Alt+Shift+4 

Alt+Shift+5 

Alt+Shift+6 

Alt+Shift+7 

Alt+Shift+8 

Alt+Shift+9 

Alt+Shift+F1 

Alt+Shift+F2 

Alt+Shift+F3 

Alt+Shift+F4 

Alt+Shift+F5 

Alt+Shift+F6 

Alt+Shift+F7 

Alt+Shift+F8 

Alt+Shift+F9 

Alt+Shift+F10 

Alt+Shift+F11 

Alt+Shift+F12 

Ctrl+Alt+Shift+A 

Ctrl+Alt+Shift+B 

Ctrl+Alt+Shift+C 

Ctrl+Alt+Shift+D 

Ctrl+Alt+Shift+E 

Ctrl+Alt+Shift+F 

Ctrl+Alt+Shift+G 

Ctrl+Alt+Shift+H 

Ctrl+Alt+Shift+I 

Ctrl+Alt+Shift+J 

Ctrl+Alt+Shift+K 

Ctrl+Alt+Shift+L 

Ctrl+Alt+Shift+M 

Ctrl+Alt+Shift+N 

Ctrl+Alt+Shift+O 

Ctrl+Alt+Shift+P 

Ctrl+Alt+Shift+Q 

Ctrl+Alt+Shift+R 

Ctrl+Alt+Shift+S 

Ctrl+Alt+Shift+T 

Ctrl+Alt+Shift+U 

Ctrl+Alt+Shift+V 

Ctrl+Alt+Shift+W 

Ctrl+Alt+Shift+X 

Ctrl+Alt+Shift+Y 

Ctrl+  ̀

Alt+  ̀

Ctrl+Shift+ ̀

Alt+Shift+ ̀

Ctrl+Alt+ ̀

Ctrl+Alt+Shift+` 

KeyPad / 

Ctrl+Keypad / 

Alt+Keypad / 

Shift+KeyPad / 

Ctrl+Shift+Keypad / 

Alt+Shift+Keypad / 

Ctrl+Alt+Keypad / 

Ctrl+Alt+Shift+Keypad / 

KeyPad * 

Ctrl+Keypad * 

Alt+Keypad * 

Shift+KeyPad * 

Ctrl+Shift+Keypad * 

Alt+Shift+Keypad * 

Ctrl+Alt+Keypad * 

Ctrl+Alt+Shift+Keypad * 

KeyPad - 

Ctrl+Keypad - 

Alt+Keypad - 

Shift+KeyPad - 

Ctrl+Shift+Keypad - 

Alt+Shift+Keypad - 

Ctrl+Alt+Keypad - 

Ctrl+Alt+Shift+Keypad - 

KeyPad + 

Ctrl+Keypad + 

Alt+Keypad + 

Shift+KeyPad + 

Ctrl+Shift+Keypad + 
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ShortKeys 
 

A shortkey is a set of characters such as abc, myname, etc. When the characters are typed into an application, the macro 
runs. To create a new macro with a shortkey, select the ShortKey option to display the shortkey edit box. In this field 

enter a series of characters from two to 32 characters in length.  

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon  

  

Note:  Before using the ShortKey option be sure to first define the shortkey default settings. Click on Options | 
Preferences | Activations - ShortKeys tab to customize the settings.  

  

ShortKey Specifications 
  

Up to 32 characters may be entered as an original shortkey. In addition, up to 3 Prefix Keys may optionally be used and 
are applied to all original shortkeys created. The following Prefix characters may be entered and used:  

  

¶ The letters A through Z (bo th upper and lower case) 

¶ The numbers 0 through 9 

¶ The following characters: !  @  #  $  %  ^  &  _  =  <  >  ?  .  ;  ,  *  -  /  +  `  '  "  )  ] and space bar 

  

Alternatively use the suffix key option and press the space bar, the enter key or a suffix  character of . , : ; ? ! or - after 

typing the shortkey to activate the macro.  

   

 

  

Macro Nickname 
Optionally assign a name to the macro to more readily determine what the macro does.  

  

Build as a Popup Menu 
Select this option to open the Menu Builder window and create a popup menu. 



 

Schedule Overview 
 

Scheduled Macros are macros that can be scheduled to play back at a specific time. Just set the schedule for the macro 
and it will play back unattended at the designated time. No need to press a hot key or click on an icon. The macro plays 

back at the selected time. In order for the macro to execute, Macro Express must be running in the background.  

  

There are a number of scheduling options available. These are  briefly described below. Click on the links for more 
detailed information.  

  

1. At Startup - Running a macro At Startup instructs Macro Express to immediately execute the macro when Macro 

Express first starts up. If Macro Express is in the Start Up group, then this type of macro would play back when 
Windows first starts.  

2. Once - Running a macro Once plays the macro back on one specific date and one specific time. 

3. Hourly - An Hourly macro runs the macro repeatedly at a specific time each hour.  

4. Daily - A Daily macro runs the macro once each day once on the days of the week selected.  

5. Weekly - A Weekly macro runs once a week at the time specified. 

6. Monthly - A Monthly macro runs at a specific time on the same day of the month each month.  

7. System Idle - Setting the schedule with the System Idle option plays back the macro after the computer  has been 

idle (no keyboard or mouse activity) for the number of minutes selected. This option allows up to 720 minutes 
after the computer has been idled.  

8. When Specified Time has Elapsed  - This option repetitively runs a macro every XX number of minut es or 

seconds. The intervals can be between 1 second and 99,999 minutes, 59 seconds. If a macro is scheduled to run 
every 1 second and the macro takes 5 seconds to execute, then this function will not operate properly.  

    If planning to use macros that w ill run more frequently than every 10 seconds, first change the Scheduler 
Frequency default setting. The default instructs Macro Express to check every 10 seconds to see if a timed macro 

is ready to play back. This number must be reduced in order for sched uled macros to play back more frequently.  

9. When Macro File Loaded - This option instructs the macro to play back when the macro file containing the macro 
is first loaded. 

  

Note:  Screen Savers prevent a Scheduled Macro from operating correctly. Focus cannot be given to a program if a 

screen saver is running. Also, the security measures built into the "Lock Workstation" function of Windows 2000, XP and 
later prevent Macro Express from executing a macro.  



 

When the Program Starts 
 

Running a macro At Startup instructs Macro Express to immediately execute the macro when Macro Express first starts 
up. If Macro Express is placed in the Start Up folder, the macro plays back as soon as Windows starts and loads Macro 

Express. 

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

Schedule 
Select the preferred schedule option. 

  

Every Time this Event Occurs 

This option plays back the scheduled macro every time Macro Express is started. 

  

Only the First Time this Occurs for the Day 

This option plays back the scheduled macro the first time Macro Express is started for the day. If the program is 

restarted, the m acro does not play back. 

  

 

  

Range   

Select a date and time range for the macro to play back from the three options available in the drop down list. These 

range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 
duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  



Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It contin ues to run at the appointed time until the 
schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 
times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 
macro is not needed on weekends. 



 

Once 
 

Use the Once schedule to play only once at one specific date and time. The macro will not play again, unless the 
schedule is reset.  

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

Schedule 
Select the Date and Time for the macro to run. Once the macro is run the first time, it will not run again.  

  

If the activation was missed, run at the next available time 

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later 

when the computer is started or Macro Express is reopened. 

  

 

 

Range   

Select a date and time range for the macro to play back from the t hree options available in the drop down list. These 
range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 

duration of t he days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  



Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the 

schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start  calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 

times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 

macro is not needed on weekends. 

  



 

Hourly 
 

The Hourly schedule runs a macro at a specific time each hour or every xx number of hours.  

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

Schedule 
Run Every [  ] Minutes After the Top of the Hour 

Enter the number of minutes after the hour when the macro is set to start. If the macro is to start at 12:15, 1:15, 2:15, 

etc., then insert 15 into the edit field.  

  

Check Again in [  ] Hours 

The default value is one, which means that the macro runs every hour. Insert the number 2 for the macro to run every 
two hours, 3 for every three hours, etc.  

  

If the activation was missed, run at the next available time 

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro 
later when the computer is started or Macro Express is reopened. 

  

Don't Run the Macro Again if the Time is Within [  ] Minutes of the Next Scheduled Runtime 

If the scheduled activation was missed, it may not be desirable to run the macro twice within a short period of 

time, such as 12:40 and 1:00. Insert a value such as 30 in this fi eld. For example, if the computer restarts at 
12:40, the macro does not run because the time is within 30 minutes of the next scheduled macro at 1:00.  

  

 

 

Range 
Select a date and time range for the macro to play back from the three options available in th e drop down list. These 

range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 
duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 



when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It contin ues to run at the appointed time until the 
schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 

times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 

macro is not needed on weekends. 

  

  

  

  



 

Daily 
 

The Daily schedule runs a macro once a day at the time specified.  

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

Schedule 
Run At 

Enter the time that the macro is to run each day.  

  

Run Every [  ] Days 

The default value is one, which means that the macro runs every day. Insert the number 2 for the macro to run every 

two days, 3 for every three days, etc.  

  

If the activation was missed, run at the next available time 

If the computer was shut down or Macro Express was closed at the scheduled macro run, this optio n runs the macro 

later when the computer is started or Macro Express is reopened. 

  

Don't Run the Macro Again if the Time is Within [  ] Hours and [  ] Minutes of the Next Scheduled 
Runtime 

If the scheduled activation was missed, it may not be desirable to  run the macro twice within a relatively short 

period of time. For example, let's say that the value is set to 12 hours, the macro is scheduled to run at noon 

and the computer is shut down before noon. If the computer is not restarted until 6:00am the foll owing day, the 
skipped macro does not run because the time is within 12 hours of the next scheduled playback at noon.  

  

 

  

Range 
Select a date and time range for the macro to play back from the three options available in the drop down list. These 

range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 



duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 
dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the 

schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start  calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 

times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 

macro is not needed on weekends. 

  

  

  



 

Weekly 
 

The Weekly schedule runs a macro once a week at the time specified. 
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Schedule 
Run At 

Enter the time of day and the day of the week that the macro is to run.  

  

Check Again in [  ] Weeks 

The default value is one, which means that the macro plays every week. Insert the number "2" to have the macro 

run every two weeks, "3" for every three weeks, etc.  

  
If the activation was missed, run at the next available time 

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro 
later when the computer is started or Macro Express is reopened. 

  

Don't Run the Macro Again if the Time is Within [  ] Days and [  ] Hours and [  ] Minutes of the Next 
Scheduled Runtime 

If the scheduled activation was missed, it may not be desirable to run the macro twice within a relatively short 

period of time. For example, insert a value of "2' in the days field. If the computer is restarted on Monday after 
being on vacation for a week and the macro is scheduled to run Tuesday, the skipped macro from the prior week 

does not run because the date is within 2 days of the next scheduled macro set for Tuesday.  

  

 

  

Range   

Select a date and time range for the macro to play back from the three options available in the drop down list. These 
range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macr o plays back during the hours of the day and for the 



duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 
dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the 

schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 

times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 

macro is not needed on weekends. 

  



 

Monthly 
 

This schedule runs a macro once a month at the selected time. 
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Schedule 
Run At 

To set the monthly schedule first enter the time of day that the macro is to play back. Then select from one of the three 

monthly date options explained below. 

  

On the [  ] Day of the Month 

Select a day of the month to have the macro run, selecting from day 1 - 31. Note:  If the 31st day of the month is 

chosen, the macro will not run during the months that only have 28 or 30 days. Select the Last Da y of the Month 
option instead. 

  
On the First - Last  

Use this option to select the first, second, third, fourth, or last day of any day of the week. For example choose to 
have the macro run on the second Tuesday of each month, the third Friday of the month, etc.  

  
On the Last Day of the Month 

Use this option to schedule the macro to run the last day of the month.  

  

Check Again in [  ] Months 

The default value is one, which means that the macro is scheduled to run every month. Insert the number "2" to have 

the macro run every two months, "3" for every thre e months, etc.  

  

If the activation was missed, run at the next available time 

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro 

later when the computer is started or Macro Express is reopened. 

  

Don't Run the Macro Again if the Time is Within [  ] Days and [  ] Hours and [  ] Minutes of the Next 
Scheduled Runtime 



If the scheduled activation was missed, it may not be desirable to run the macro twice within a relatively short 

period of time. If th is is the case, then insert a value such as 10 in the days field. If the computer is restarted on 
the second Monday after being on vacation and the macro is scheduled to run on the third Tuesday, the skipped 

macro will not run because the time is within 10  days of the next scheduled macro set for Tuesday.  

  

 

  

Range  

Select a date and time range for the macro to play back from the three options available in the drop down list. These 
range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 

duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It contin ues to run at the appointed time until the 

schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 
times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 
macro is not needed on weekends. 

  



 

System Idle 
 

Setting the schedule with the When the System Has Been Idle option plays back the macro after the computer has been 
idle (no keyboard or mouse activity) for the number of min utes specified. This option allows for up to 720 minutes after 

the computer has been idled.  
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Schedule 
After the Computer has been Idle for [  ] Minutes 

Insert the number of minutes the computer must be idle (no keyboard or mouse activity) before the macro starts.  

  

Run Every [  ] Minutes 

This option plays back the macro every X number of minutes if the macro does not use the keyboard or mouse to  
change the idle state of the computer.  

  



Example 

In the image above, the scheduler waits for the system to be idle for 10 minutes. The 

macro waits 12 minutes before running the macro.  

  

If the macro does not require use of the keyboard or mouse, it plays  back again in 12 

minutes. 

  

If the macro does change the idle status of the computer, then the macro does not play 
back again until the system has been idle for 10 minutes followed by the 12 minute wait 

period. 

 

Only Run Once 

Select this option to only run the macro once after the computer has been idle for the number of minutes specified.  

  

 

  

Range   



Select a date and time range for the macro to play back from the three options available in the drop down list. These 

range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 
duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 
dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It contin ues to run at the appointed time until the 

schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 

times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 

macro is not needed on weekends. 

  

  

  



 

When a Specified Time has Elapsed 
 

The When a Specified Time has Elapsed option repetitively runs a macro every XX number of hours, minutes and/or 
seconds.  
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Schedule 
Run Every 

Enter the time between every scheduled run of the macro. If the macro is to run every 30 minutes, then set the hours 
and seconds to 0. Set the minutes to 30.  

  

Note 1:   If a macro is scheduled to run every 1 second and the macro takes 5 seconds to execute, then this function will 

not operate properly.  

 

Note 2:  If the macro is scheduled to run more frequently than every 10 seconds, it is necessary to change the Scheduler 

Frequency default setting. This setting instructs Macro Express to check every 10 seconds to see if a scheduled macro is 

ready to play back. Reduce this number in order for scheduled macros to play back more frequent ly. 

  

 

  

Range   

Select a date and time range for the macro to play back from the three options available in the drop down list. These 

range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 
duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date 

when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  



Run the Macro Between the Dates and Time  

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the 
schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 
times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 
macro is not needed on weekends. 

  

  

  

  

  



 

When the Macro File is Loaded 
 

This is similar to the At Startup schedule with one difference. Any time that the macro file containing the scheduled 
macro is loaded, the macro runs. When Macro Express loads, the file opens and the macro plays back.  

  

 
Macro Express Explorer > Macro > Add Macro - Or click on New Macro Icon 

  

Schedule 
Every Time this Event Occurs 

Select this option to play back the macro every time the file loads. If another macro file is opened and the n the original 
file containing the scheduled macro is reopened, the macro executes. Or if Macro Express is shut down during the day 

and later restarted, the macro runs.  

  

Only the First Time this Occurs for the Day 

This option limits the playback to just o nce a day. The first time the file loads for the day, the macro will play back - but 
not afterwards, until the next day.  

  

 

  

Range   

Select a date and time range for the macro to play back from the three options available in the drop down list. These 
range options are described below. 

  

Run the Macro Within this Date Range 

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the 

duration of the days selected. Select the Start Date when the macro i s to first start running. Then select the End Date 
when the macro ceases to run. 

  

Run Between These Times Each Day 

Select a start and an end time for the macro to run.  

  

Run the Macro Between the Dates and Time  



Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the 

dates and times specified. 

  

Run the Macro Indefinitely 

Run the Macro Indefinitely does not stop the macro on a specific date. It contin ues to run at the appointed time until the 
schedule is canceled or the macro is disabled or deleted.  

  

Start Calculating the Next Run Time At 

Select the date and time to start calculating the next run of the macro.  
  

Run the Macro Between These Hours of the Day 

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end 
times. 

  

Run the Macro on These Days of the Week 

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the 
macro is not needed on weekends. 



 

Window Title 
 

The Window Title activation instructs the macro to execute any time a specific event occurs for the window title selected.  
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Window Title to Look For 
In the edit box, enter the title of the Window for the macro to find. The window title is that which appears in the caption 
bar of a window. Macro Express examines all window titles running on the computer in an attempt to find a match.  

  

Click on the Browse button to see a list of all windows currently running on the computer. This includes both windows 

that are visible when open and other system windows that are not seen, though open. Select the window and click OK.  

  

Partial Match/Exact Match 
The Window Title does not need to be an exact match. A partial match will work. For example, if looking for the Windows 

Notepad program, one could insert "notepad" or "notep". This is particularly useful as some Window Titles change based 
on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".  

  

The Title contains Wildcards 

Select this option if a wildcard is included in the window title name. A wildcard includes the " * " or " ? " char acters in 
the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.  

  

Event to Activate On 
Select from one of four different events to trigger the macro. These are described below.  

  

Window Gains Focus - The macro starts as soon as the specified window becomes the active window and has 

focus.  

Window Loses Focus - The macro begins playback as soon as the window is minimized or sent to the background. 

Window is Closed - The macro starts when the defined window is closed. 

Window is Opened - The macro starts when the specified window is open. 

  

 



  

Macro Nickname 
Optionally assign a name to the macro to more readily determine what the macro does.  

  

Build as a Popup Menu 
Select this option to open the Menu Builder window and create a popup menu.  

  



 

Mouse Event 
 

Create macros that run when the mouse button or a combination of mouse buttons is clicked.  
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Buttons to Activate the Macro With 
Macro activation can be assigned to the Left, Middle or Right mouse buttons or a combination of the three buttons.  

  

What to Click On 
After assigning the mouse button or buttons to press, select what to click on  in order to trigger the macro - Area on 

Screen, Area on Window or Window Part. These are explained below. 

  

Area on Screen 

Use this option to define regions on the screen that can be assigned as a mouse activated macro. Clicking on the 

assigned area triggers the macro. This option requires the input of four pixel coordinates - Left, Top, Right, and 
Bottom. Click on the area within these four pixel coordinate s to start the macro.  

  
Area on Window 

Use this option to define regions on a window that can be assigned as a mouse activated macro. Clicking on this area 
of the window triggers the macro. This option requires the input of four pixel coordinates - Left, Top, Right, and 

Bottom. Click on the area within these four pixel coordinates to start the macro.  

  

Locator 

Click on the Locator button to launch this small utility to quickly help define the pixel coordinates. After  the 
locator is running, move the mouse to the upper left corner of the region to be defined. Press Ctrl+Space to 

insert the pixel coordinates in the Left and Top fields. Then move the mouse to the lower right corner of the 

region to be defined. Press Alt+Space to insert the pixel coordinates into the Right and Bottom fields. Press OK 
to save the coordinates. 

  

This action defines a square or rectangular area on the screen. Click within the defined square or rectangular 

area with the designated mouse button  to start the macro.  

  



Window Part 

Define a macro to start by clicking on a specific part of a window. Parts include the window border, window title bar, 
window menu, horizontal scroll bar, vertical scroll bar, system menu, minimize button and maximize bu tton.  

  

Note:  A few options have been excluded because they will interfere with Windows. These include such things as Left 
Mouse with the Maximize or Minimize buttons. 

  

 

  

Macro Nickname 
Optionally assign a name to the macro to more readily determine what  the macro does. 

  

Build as a Popup Menu 
Select this option to open the Menu Builder window and create a popup menu.  



 

Control Event 
 

For our purposes, Control refers to the identifiable parts of a specific application window. Controls may include such 
things as a button, an edit box, a toolbar, a window title bar or others. The control may be part of the main application 

window or be part of a child window (a window within a window).  
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With Control Activation selected, the macro plays back when the control gains focus or the window with the control gains 
focus. In the example above the control name is listed. The program .exe is displayed followed by the window 

component that must be act ive in order for the macro to play back.  

  

 

  

Launch Utility 
The first step is to select the control that will activate the macro. Below is an image of the Capture Window Control 

window that appears when launching the control utility.  

  

To select a Window Control place the mouse cursor on the crosshair image, hold down the left mouse button and drag 
the mouse over the control. When dragging the crosshairs over title bars, buttons, edit boxes, forms, toolbars, etc., the 

outline of the controls are highlighte d. Once the control needed is highlighted, release the left mouse button. Click on the 
Save button to return to the Create New Macro window. The control details are saved in the edit box.  

  



 
  

Save the Control Using the Contents of the Control 

This option makes the capture of a control more specific and captures the text found in the control. So for example, 
if capturing an edit box with the word Test in it, during playback the macro looks for the edit box and verifies tha t it 

contains the word Test. If the edit box text is changed to something else, such as Reset or left blank, then the 
control (C1) that was captured will not match the actual control in the window - edit box. 

   

Note: Not every button, menu item or compone nt on a program is actually a Control. Sometimes the only control in a 
given program is the window or dialog that pops up when the program starts. We have also noticed that many of 

Microsoft's programs seem to have fewer controls than programs from other m anufacturers. How the controls work will 

depend upon the way the program in use is designed.  

  

Hide Macro Express 
Hide Macro Express does what it implies. The program hides or gets out of the way after pressing the Launch Get Control 
Utility. This makes it  easier to locate the application containing the control to capture.  

  

 

  

Launch the Macro When  
After selecting the control, decide when to activate the macro. Choose either when the control gains focus or when the 
window that contains the control gains focus.  

  

The Control Gains Focus 

This option requires that the control be part of the active windo w and the control gain focus. For example the mouse 
cursor could be in an edit box, giving focus to this control. Or a button may be highlighted and have control.  

  
The Control's Window Gains Focus  

With this option the macro starts when the window contai ning the selected control gains focus. 

  

Control Details 
This edit box lists the details of the selected control using the Launch Utility. The information should match what was 

listed in the Capture Window Control window.  

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later help more readily determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click on the OK button to open the Menu Builder and create a popup menu. 



  

  



 

Directory Modification 
 

This activation type looks for changes to files in a folder or to the folder. A macro starts when a change is made to a file 
in the selected folder or to the folder itself. Some of the available options include the macro looking for changes to file 

size, attributes, write tim e, security descriptor or checking if a file has been renamed or deleted.  

 

Note:  There is a maximum of 64 Directory Modification macros that may be active at any one time. Any macros over the 
64 limit are ignored. This total spans multiple macro files tha t may be open. 
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Path to Watch 
Insert the folder path for the macro to monitor or click on the Browse button to select the folder path.  

  

What to Watch 
Select from a list of file activities that the macro can monitor. These activities are explained below.  

  

Create, Rename or Delete a File 

The macro activates when a file in the selected folder is either created, renamed or deleted.  

  
Create or Delete a Directory 

The macro starts when the specified folder is created or deleted.  

  
File or Directory Attributes Change 

The macro plays back when the attributes of a file in the folder or the folder itself is cha nged. The file attributes may 

include the Read-Only flag, Archive setting, etc.  

  
A File's Size Changes 

Use this option to initiate a macro when the size of a file in the selected folder changes.  

  
A File's Last Write Time Changes 

The macro starts when the last write time (or modified time) of a file in the folder changes.  

  



A Security Descriptor Changes 

Security options are only available in Windows Vista, 2003, XP Pro, 2000 and NT4. The macro starts if one of the 
security options of a file in the folder or the folder itself has changed.  

  

Watch Subfolders 
Select this option to monitor any subfolders of the primary folder chosen.  

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more readily help determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click on the OK button to open the Menu Builder and create a popup menu. 

  



 

System Event 
 

The System Event activation looks for changes to the system. The macro starts when the specified system change 
occurs. 
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Incoming Message 
Windows is a message based operating system. There are messages broadcast throughout the system when certain 

events occur, such as when a hardware component is added or removed. 

  

This is another way for custom applications to launch macros. Rather than passing the nickname through the 
postmessage routine, use this method to post a single message. 

  

When using the Incoming Message activation, select from the four types of messages available.  

  

Use Constants File 

The user specifies an ini file containing a list of constant names and their values. The "Message to Post" field should 
contain a constant name from this file.  

  

An example would be the WM_LBUTTONDOWN message in the PostMessage.ini file. In the file, the following line 

appears: 

   

WM_LBUTTONDOWN=513 

  

This means that when the user specifies WM_LBUTTONDOWN as the message, message 513 is actually sent. 

  
Constants File      

The user specifies in the "Message to Post" field a message number to send to the specified control. 

  
Offset from WM_USER 

WM_USER is a Windows constant that marks the beginning of the messages that programmers can use for anything. 

In this case, the user specifies either a positive or negative number that is added to WM_USER. Currently, Windows 



defines WM_USER as 1024. 

  
Use RegisterWindowMessage 

This command allows the user to enter a constant string that can be used by Windows to generate a message. This  
is primarily used to communicate with other applications that have registered the same message.  

  

Microsoft Definition of RegisterWindowMessage 

 

The RegisterWindowMessage function defines a new window message that is guaranteed 
to be unique throughout the  system. The message value can be used when sending or 

posting messages. 

  

The RegisterWindowMessage function is typically used to register messages for 
communicating between two cooperating applications. 

  

If two different applications register the same m essage string, the applications return the 

same message value. The message remains registered until the session ends. 

  

Only use RegisterWindowMessage when more than one application must process the same 

message. For sending private messages within a window class, an application can use any 

integer in the range WM_USER through 0x7FFF.  

  
Message 

The message input into this field comes from one of three sources. The message will be a constant from the 
Constants file, a string passed to RegisterWindowMessage, or a value from WM_USER. 

  
WParam - LParam 

These fields allow the user to specify the WParam and LParam parameters. The contents of these parameters 
depend upon the message being sent. These values can be found in the Platform API library at 

http://msdn.microsoft.com.  

  

Note:  Consult http://msdn.microsoft.com for a list of messages available.  

  

Note:  When Macro Express is installed, three .ini files ( PostMessage.ini, PostCommCtrl.ini and PostRichEdit.ini ) are also 

installed into the Macro Express folder. The default path is C:\Program Files\Macro Express Pro. These .ini files contain 
message definitions that can be used for reference. Double click on the files to open and view in Notepad or Wordpad.  



  

  

System Colors Change 
Use this option to start a macro starts a change is made to the Windows system colors on the computer. Note:  This 

option is not available for Windows Vista. 

  

  

Resolution Change 
Use this option to activate a macro when the system's screen resolution is changed. 

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more help readily determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click on the OK button to open the Menu Builder and create a popup menu. 

  

  



 

Process Event 
 

The Process Event activation method initiates a macro when a Process first starts or when it closes. 
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Process to Watch 
Click on the Browse button to select the process to monitor. Browse through a list of processes in the Start menu or from 
a list of processes currently running on the computer. Or look for where the process is installed on the computer.  

  

What to Watch For 
Process Starts Running 

The macro activates as soon as the chosen process starts running. 

  

Process Stops Running 

The macro starts when a process ends or closes. 

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more readily help determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click on the OK button to open the Menu Builder and create a popup menu. 

  



 

TCP/IP 
 

The TCP/IP activation monitors when an Internet or Network connection has been made or released.  
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TCP/IP Stack is Available 
This option activates the macro when an Internet or Network connection is successful.  

  

TCP/IP Stack is Unavailable 
This option activates the macro when all Internet or Network connections are released.  

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more readily help determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click OK to open the Menu Builder and create a popup menu. 

  

  



 

Clipboard Text 
 

This activation method starts a macro based on the contents of the clipboard. Select whether the clipboard does or does 
not match the text entered into the edit field. Or choose whether the clipboard contains or does not contain specific text.  
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Equals / Does not Equal 
These options require that the text in the clipboard match or not match the word or phrase selected as a trigger. For 

example, suppose Macro Express is listed as the clipboard text trigger and the Equals option is selected. The macro starts 

when the words Macro Express are copied to the clipboard. 

  

The macro starts if the activate option is changed to Does not Equal and text other than Macro Express is copied to the 

clipboard. Note:  Use the Does not Equal option with caution as this may trigger macros unexpectedly when copying 

items to the clipboard.  

  

Contains / Does not Contain 
These options require that the text in the clipboard contain or not contain the word or phrase selected as a trigger. For 
example, suppose Macro Express is listed as the clipboard text trigger and the Contains option is selected. The macro 

starts when the words "I really like Macro Express" are copied to the clipboard. It plays back because the trigger - Macro 
Express - is part of the clipboard contents.  

  

The macro starts if the option is changed to Does not Contain and text that does not include the word s Macro Express is 

copied to the clipboard. Note: Use the Does not Contain option with caution as this may be trigger macros unexpectedly 
when copying items to the clipboard.  

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more readily h elp determine what the macro does.  

  

Build as a Popup Menu 



Select this option and click on the OK button to open the Menu Builder and create a popup menu. 

  



 

No Activation (None) 
 

It is possible to create a macro and not assign any activation key to the m acro. There are two primary uses for the No 
Activation (None) option. First, create generic macro templates that can be incorporated into other macros - a set of 

instructions useful for insertion into several other macros. The Macro Run command allows for inserting No Activation 

macros into other macro scripts. 

  

A second use for this option is to place the macro in a popup or floating menu. A macro activation is not necessary if the 

macro is part of a popup or floating menu. The only way to invoke the macr o would be through the menus.  

  

 

  

Macro Nickname 
Optionally assign a name to the macro to later more readily help determine what the macro does.  

  

Build as a Popup Menu 
Select this option and click on the OK button to open the Menu Builder and create a popup menu. 



 

Stopping a Macro 
 

Occasionally it may be necessary to stop a running macro before it has finished. There are several ways to stop a running 
macro.  

  

Aborting a Macro 
If the Running icon displays when a macro is running, right mo use click on the icon in the system tray to stop the macro. 
Or press the default key sequence of Scroll Lock and Pause to stop the macro. Change the default to Win + ` or the 

Pause key by going to Options | Preferences | Playback | Miscellaneous. 

  

Any of these options will cancel a macro that is playing. However, please note that macros that consist of many 
keystrokes can send the keystrokes rather quickly and they are buffered in Windows. Once such commands have been 

buffered in Windows, aborting a macro does not cancel them. In these cases, it may appear that the abort command did 
not work when in reality the macro has already finished issuing its commands and Windows is now processing them.  

  

If more than one macro is running, all macros will be stopped when initiating any of the above mentioned actions.  

  

Note:  The Timed Delay in Seconds and the Wait for Time to Elapse commands suspend Macro Express for the amount of 

time specified. During this delay time the macro cannot be terminated.  

  

Macro Stop 
The Macro Stop command stops the execution of a macro before the macro steps have completed. Insert the Macro Stop 
command into the macro script. Whenever this line in the macro is reached, the macro terminates. In most cases this 

command is used in conjunction with a conditional statement. For example, if a desired condition is not met, terminate 

the macro. 

  



 

System Macros 
 

Macro Express defines several system macros for a variety of program functions. The macros are stored in a System 
Macro file and are available with any macro file currently open. Each of the system macros is described below. 

  

Reassigning a System Macro hot key 
The system macros are assigned to hot keys but may be renamed at any time to something that is easier to remember. 
To rename a system macro, expand the System Macros category right mouse click on the macro. Left click on Properties 

from the menu to open th e System Macro window as shown below. Click on the Change button and select another hot 
key combination. The new hot key will display in the Activations column of the Macro Express Pro - Explorer window. 

  

 
Macro Express Explorer > Open System Macros Category > Double Click on System Macro 

  

 

  

Terminate Macro Express 
Pressing the Ctrl+Alt+Shift+V system hot key terminates Macro Express. Use this key sequence to quickly and easily 

close Macro Express.  

  

Run Macro Express Editor 
Pressing the Ctrl+Alt+Shift+W hot key activates the Macro Express Pro - Explorer. It brings the Explorer program to the 

forefront from it's hidden or minimized state. This is a simple way to activate the program without using the mouse.   

  

Start/Stop Capture 
Press Ctrl+Alt+Shift+X to start capturing keystrokes or mouse movements for a new macro. When finished capturing, 
press Ctrl+Alt+Shift+X again to stop recording.  

  

Resume Pause 
If a macro contains a Pause command press the Ctrl+Alt+Shift+Y hot key to resume the macro and close the Pause 
window, instead of using the mouse to click the "Resume" button   

  

Menu of Macros for Top Most Window 
Pressing  the Ctrl+Alt+Shift+Z hot key opens a popup window listing al l macros that are specifically defined for the 

window open when the hot key is pressed.    

  

Select which information to display in this popup menu. Choose whether to display the icons associated with the macros, 
the name and activation method defined for each macro in the menu, or the first part of a macro - the first line or two of 

a macro.  

  

Suspend / Resume Macro Express 
Pressing the Ctrl+Alt+Shift+U system hot key toggles between suspending Macro Express and resuming its active status. 

No macros will play back while Macro Express is suspended. 

  

Another way to suspend the program is to right mouse click on the Macro Express icon in the system tray. Left click on 

Suspend from the menu that opens. The menu item displays Resume when the program is suspended. The icon in the 

system tray is changed to a red circle with a line through it when Macro Express is suspended. 

  

Capture a Temporary Macro 
This is a quick way to capture a macro for testing purposes. No assigning of hotkeys or checking settings is required. The 
macro is saved temporarily for playback. Press the Ctrl+Alt+Shift+T hot key to start the capture.  

  



Play the Captured Temporary Macro  
Press Ctrl+Alt+Shift+S to start the play back of the temporary macro created.  

  

  

  

  

  

  



 

Macro Explorer 
 

By default Macro Express opens to the Macro Express Pro - Explorer window. This window displays a list of macros 
contained in the file currently open. The Macro Explorer is the starting point for creating new macros or editing existing 

ones. 

  

 
Left click on the Macro Express icon in the System Tray or press the system macro Ctrl + Alt + Shift + W  

  

Actions 
The icons in the left hand column of the Macro Explorer window are the primary methods of navigating through the 

program. Clicking on any of these icons will load a different program function.  

  



 
Macro Explorer 

Returns to the Macro Explorer window if currently viewing the Recycle Bin. Otherwise this action is not available.  

  

New Macro 

Click on the New Macro icon to start the process of creating a new macro. 

  

Edit Macro 

Highlight a macro in the Explorer list and click on  the Edit Macro button. This opens the macro in the Script Editor in 
order to review or make changes to the macro script.  

  

Capture 

Clicking on the Capture button starts the macro recording process.  

  

Quick Wizards 

Click on this button to start the Quick Wizard module. The Quick Wizards prompt through the process of creating a 

macro. 

  

Recycle Bin 

The Recycle Bin button opens the Macro Express Recycle Bin which displays the macros that have been previously 
deleted. Permanently remove the macros from the Recycle Bin or restore one or more to the original macro file.  

  

Categories 
Use the Categories option to assign macros to user defined categories. With large numbers of macros created, the 
categories provide an easy way to locate macros for further editing, refinement, exporting, etc.  

  

For example create a Password category to hold any macros containing important passwords or assign any MS Word 

specific macros to a MS Word category. This makes it easy to quickly find the macro needed.  

  

 
Upon installation there are three default categories - System Macros, All Categories and Unassigned. These categories 
may not be renamed or deleted. Additional categories may be created as shown in this example. Since Macro Express 

allows more than one macro file to be open at a time, multiple sets of categories may be displayed - a set for each open 

file. 

  

Note: A macro may only be assigned to one category.  

  



Macros 
The Macros section displays the list of macros in the file or category that is currently open. When saving macros in the 
editors, quick wizards or with a macro capture, the program will return to the Macro Explorer. The list of macro 

information is displayed in six columns. 

  

Index 

The index column lists the macros in the order that they were created. The first macro created in the file displays as 

number 1, the second macro as number 2, etc.  

  
Nickname 

Optionally assign a nickname to any macro to help more readily identify the purpose of the macro. Any not assigned 

a nickname display with a blank field.  

  
Activation 

The Activation column displays the method selected to execute the macro. This column displays the hot key 

combinations, any timed macros, the letter combinations  used for any shortkeys or any other type of 

activation method chosen. If more than one activation is assigned to the macro, this column displays Multiple for that 
macro. If the Show Preview Pane option is selected highlight the macro to view all of the ac tivations in this pane.  

  
Scope 

This column lists the macro scope, whether it is global, global except, window specific, program specific, a system 
macro, a popup menu or a floating menu.  

  
Category 

This column lists the category to which the macro was assigned.  

  
Modified  

The Modified column displays the date and time that the macro was last modified.  

  
Last Run 

The Last Run column displays the date and time that the macro was last run.  

  

Sorting Macros 
To quickly sort the list of macros displayed, click on one of the column headers, Nickname, Activation, Scope, Category, 

Modified or Last Run. The macros will be sorted based on the column header selected. Click on the header a second time 

to reverse the sort order.  

  

Right Click Context Menu 
Right mouse click on a macro in the macro list to open the context menu. The menu options include Run Macro Now, 

Copy Macro, Edit Macro, Enable/Disable Macro, Recapture Macro, Delete Macro and Macro Properties.  

  

 

 

Keyboard Shortcuts in Macro Express 
Below is a listing of the Keyboard Shortcuts available in the Macro Explorer. 

Keystroke  Action  

Ctrl+F  Find (text in Nickname field)  

F3   Find Again 

Delete  Delete highlighted macro 

Ctrl+P  Print macro list 

  

 



Below is a list of the keystroke equivalents for navigating through the program. These keystrokes perform the same 

function as clicking on the Actions Icons in the left hand column of the program.  

Keystroke  Action  

Alt + E  Return to Macro Explorer from Recycle Bin 

Alt+N   New Macro 

Alt + E  Edit highlighted macro 

Alt + P  Capture 

Alt + Q  Quick Wizards 

Alt + B  Recycle Bin 

  

  

  

  

  



 

File Menu 
 

New File 
Macro Express allows for creation of multiple files with different macros in each file. Click on the File | New File option t o 

create a new file. A dialog box appears prompting for a file name and folder location.  

  

Open File 
Click on this option to open a previously created macro file. A dialog box appears prompting to select the file.  

  

Close File 
If more than one macro file is currently open, use this option to close one of the files. A dialog box appears prompting to 

select the file and choose from which folder.  

  

Backup Macro File(s) 
This option immediately backs up the macro file that is currently open. If using the automatic backup schedule, this 
option does disturb the schedule previously created. It uses the settings defined in the Backup Preference panel, such as 

where the backup is saved and how many backup copies are created. 

  

Restore Macro File 
Use this option to restore from a backup file. A Windows dialog will open prompting to select the backup file. The dialog 

opens to the folder designated in the Backup preferences panel for file backups. If the backup options were recently 
changed, then it may be necessary to browse to the location where previous backups were stored.  

   

Performing the restore closes the file currently open and replaces it with the backup file selected.  

  

 

  

Reopen 
This is a convenient way to open a macro file previously used. This option displays the last several macro files opened. 
Click on the desired file to load into Macro Express. 

  

This may close all other open macro files depending on the Close open macro files before loading another macro 

file preference setting selected. 

 

  

Import 
There are three different import options available in Macro Express. Click on the topic of interest below to obtain mor e 

information.  

  

Import Macros 

Import Text File  

Import Playable Macro 

  

Export 
There are three different export options available in Macro Express. Click on the topic of interest below to obtain more 

information.  

  

Export Macros 

Output Macro Information  

Export as Playable Macro 

  

 

  

Print Macro List 
Click on File | Print Macro List or click on the speed button to print a list of all macros currently assigned. The list cont ains 

the activation method, such as the hot key combination used, the nickname assigned, if any, and macro scope (global, 
system, window specific or program specific). The list includes the information as shown in the Macro Explorer window.  



  

Printer Setup 
Select this option to ensure printer settings are accurate before printing the macro list. 

  

 

  

Terminate Macro Express Editor 
Selecting this option closes the Macro Express Pro - Explorer window but leaves the Player running. The macros still run 
with the Explorer window closed.  

  

Terminate Macro Express Editor and Player 
Selecting this option closes the Macro Express Pro - Explorer and Player. It shuts down the entire program, at which point 
no macros can run. 



 

Import Macros 
 

The import and export functions are convenient methods to transfer macros between Macro Express users. Use the 
Export command to save the macros to a disk or drive. On another computer import the macros from the disk, flash 

drive, or similar device. 

  

 
Macro Express Explorer > File > Import > Import Macros  

  

To import macros, click on File | Import | Import Macros. A Select a File to Import window opens with a standard dialog 
box to browse through folders to find the correct file. All Macro Express macro files have a file extension of .mex. 

Highlight the file to import and click  on Open. A list of all macros found in that file are displayed.  

  

Please Select the Macros that you would Like to Import 
Highlight the macros to import by clicking on each macro.  

  

Select All 

This option highlights all macros in the file so that all are imported.  

  
Clear 

This option clears any highlighted macros so that none are imported until a new selection is made.  

  

Click on the OK button to start the import process. A progress bar displays  during the import process until the Import 
Complete message appears. Click OK to return to the Macro Explorer. This finishes the process and the macros are now 

found in the current file.  

  

Note:  It is also possible to import or export popup  menus along with the macros in the menu and have them correlate 
correctly after the import or export. This can be done as long as the macros included in the popup menu are imported or 

exported at the same time as the popup menu. Any macro that is not imported or exporte d along with the popup menu 
will be removed from the menu.  



 

Import Text File 
 

Selecting File | Import | Import Text File from the Macro Express Pro - Explorer menu imports a group of ShortKey or Hot 
Key macros. A standard Windows dialog box opens prompting to navigate and select the text file to import.  

  

The text file must be in a specific format. An improper format will cause unpredictable results. The formatting of the lines 

in the text file is described below.  

  

Line 1 - The first line requires an <IT EM NAME> tag followed by the shortkey or hotkey name. The hotkey name is 

the key sequence used and must be in the format found in the Create New Macro window. If a match is not made on 
one of these, then it is assumed that the name supplied is a shortkey.  

  

Line 2 - This line contains the nickname assigned to the macro.  

  

Line 3 - Line 3 contains the macro text and commands. This line may span multiple lines as shown in the examples 

below.  

  

The <ITEM NAME> tag marks the start of a new macro in the text f ile. 

 

Example 

This example shows the format for two shortkey macros followed by a hot key macro to 
be imported. 

  

<ITEM NAME>issadd 

Our Address 

Insight Software Solutions, Inc.  

P.O. Box 106 

Kaysville, UT 84037 

<ITEM NAME>downm 

Download Macro Express  

You can download a 30 day evaluation copy of Macro Express from 
www.macros.com/download.htm.  

<ITEM NAME>Ctrl+Shift+m  

ME4 Overview 

Macro Express is the premier macro utility on the market. With Macro Express, you can 
record, edit and play back mouse and keyboard macros. Its powerful tools and robust 

features will noticeably boost your productivity.  

 

 

  

 

  

  

  

  

  

  

  

  

  

  



  

  

  

  



 

Import Playable Macro 
 

A "Playable Macro" file format is available. Files with an .MXE file extension are similar to .EXE files. Double clicking on 
the .MXE file from within Windows Explorer plays back the macro.  

  

Macro Express is not required to be running to execute the .MXE macro, though installation of the Macro Express player 

is necessary. The .MXE file may also be executed from a command line parameter to run a batch file.  

  

This option is used for importing a playable macro from another machine on a network or from a di sk that contains a 
playable macro and converting it to a .MEX macro.  

  

Click on File | Import | Import a Playable Macro. A box appears prompting to search for the .MXE file to import. Once 

located, highlight the file to import and click OK to import the f ile. The Copy Hot Key window opens prompting to assign 
a hot key or other method for executing the macro. The imported macro is then placed into the list of macros in the 

Macro Express Pro - Explorer. 



 

Export Macros 
 

The import and export functions are a convenient way to transfer macros between Macro Express users. Use the Export 
command to save macros to a disk or drive. On another computer Import  the macros from the disk, flash drive, or similar 

device. 

  

 
Macro Express Explorer > File > Export > Export Macros 

  

Please Select the Macros that you Would Like to Export  
To export macros, click on File | Export | Export Macros. A window opens showing all macros from the macro file 

currently in use. Highlight the macros to export.  

  

Select All 

This option highlights all macros in the file so that all are exported.  

  
Clear 

This option clears any highlighted macros so that none are exported until another selection is made.  

  

Include the Category Information in the New File 
This option saves the category information in the new file if the macros selected for export have been a ssigned to 

categories.  

  

Please Enter the Name of the New Macro File 
Enter the name and file path of the file where the macros will be exported. Or click on the browse button to navigate to 

the location of the file to be saved.  

  

Click OK to export to the new file. The file is saved as a Macro Express macro (.mex) file which can be opened directly by 
Macro Express using the File | Open File menu or the macros may be imported.  

  

Note:  It i s possible to import or export popup menu macros along with the macros that were in them and have them 

correlate correctly after the import or export. This can be done as long as the macros in the popup menu are imported or 



exported at the same time as the  popup menu. Any macro that is not imported or exported along with the popup menu 

will be removed from the popup menu as an entry.  



 

Output Macro Information 
 

Use this option to select what information from the macro file to save to a text file. As shown i n the window below, select 
which items to output and click OK. A standard dialog box prompts for a file name and folder destination for storing the 

data. 

  

The newly generated text file contains selected information about each macro in the file.  

  

 
Macro Express Explorer > File > Export > Output Macro Information  

  

Macro Information to Output 
Activation - Lists the Hot Key, ShortKey or other activation of the macro.  

Scope - Lists the scope of the macro. 

Script - Displays the macro script in Direct Editor format.  

Name  Lists the name assigned to the macro. 

Icon Path - Lists the names of the icons used. The information can then be printed in any text editor.  



 

Export Playable Macro 
 

A "Playable Macro" file format is available in Macro Express. Files with an .MXE file extension are similar to .EXE files. 
Double clicking on the .MXE file from within Windows Explorer, My Computer or the desktop plays back the macro.  

  

Macro Express is not required to be running to execute the .MXE macro, though installation of the Macro Express player 

is necessary. The .MXE file may also be executed from a command line parameter to run a batch file or similar.  

  

The Export As Playable Macro option exports (or creates) any defined macro as a playable macro. From the Macro 
Express Pro - Explorer window highlight the macro to export. Next, click on File | Export | Export as Playable Macro. A 

standard dialog box prompts for a file name and folder destination for storing the .MXE file.  

 

Note:  Any activation assigned to the original macro, such as a hot key, schedule or other, is not stored in the playable 
macro. Double click on the .MXE file to activate the macro. 



 

New Macro 
 

To create a new macro, click on Macro | New Macro from the men u or click on the New Macro icon to open the Create 
New Macro window. The first step is to select the type of macro activation needed. The hot key activation is the default 

selection. After assigning the activation type, enter a macro nickname and press OK to proceed to the Script Editor. 

  

 
Macro Express Explorer > New Macro Icon or Macro > New Macro 

  

Hot Keys                
To activate a new macro with a hot key, make sure the Hot Key choice is selected. Place the cursor in the edit box and 

hold down the Hot Key combination to use. The combination pressed is placed in the edit box. When the macro is 
complete, press this hot key combination to activate the macro.  

  

Or scroll through the list of keys and highlight the one wanted. This also places the hot key combination in the edit box.  

  

Note: Use the hot key combinations displayed in red with caution. These combinations may conflict with basic Windows 
functionality, such as the clipboard copy (Ctrl + c).  

  

ShortKeys                
Select the ShortKey option and type in the shortkey (up to a 32 letter code) to use to activate the macro. A shortkey is a 
set of characters such as abc, myname, etc. See the program specifications for a complete list of characters accepted as 

ShortKeys.  

  

The macro runs when the characters are typed into an application that accepts text input. The ShortKeys activation will 
not trigger a macro from t he Windows desktop or other applications that do not accept text input.  

  

Note:   Before using the ShortKeys feature click on Options | Preferences | Activations | ShortKeys tab to define the 

settings. 

  

Scheduled Macro          

Selecting Schedule activates the Scheduler options. Select the schedule wanted and click OK to build the macro in the 
Script Editor. The macro then plays back at the time designated.  



  

Window Title         

This option instructs a macro to execute any time the selected Window Title has focus. In other words, the macro runs 

once the window is activated. 

  

In the edit box, enter the title of the Window that will start the macro. The title of the window is that which appears in 

the caption bar of a window. Macro Express examines all Window Titles running on the computer in an attempt to find a 
match. The Window Title does not need to be an exact match.  

  

A partial match also works. For example, "notepad" or "notep" would be sufficient for the Windows Notepad program. 

This is particularly useful as some Window Titles change based on which file is open.  

  

Case sensitivity is not required. For example, "NOTepad" works as well as "notepad". 

  

Mouse Event      
This option uses mouse clicks to activate macros. Two different methods are available.  

  

1. Define regions on the screen that can be assigned to the left, middle or right mouse button. Clicking on the 

defined area of the screen triggers the macro. Macros may be global, window or program specific.  

  

2. The other option is to click on a specific part of a window to execute the macro. Window parts include the 
window border, window menu, window caption bar, horizontal scroll bar, vertical scroll bar, system button, 

minimize button and maximize button. Macros can be assigned to the left, mid dle or right button and can be 

global, window or program specific. A few options have been excluded where they will interfere with essential 
functionality of the windows such as Left Mouse with the Maximize or Minimize buttons.  

   

Control Event             
The Control option activates a macro when a specific Window control becomes active or the control's window becomes 

active. The control may be a window button, edit box or another identifiable portion of a window.  

  

Directory Modification 
The Directory Modification activation looks for changes to files or folders. When a change is made to the file or folder 

specified, the macro will start. Among the options, the macro may look for changes to file size, attributes, write time or if  
a file has been renamed or deleted.  

  

System Event 
The System Event activation looks for changes to the system such as an incoming message, resolution change or system 

color change. When the specified system change occurs, the macro starts. 

  

Process Event 
The Process Event activation method starts a macro when a Process starts or shuts down. 

  

TCP/IP 
The TCP/IP activation monitors when an Internet or Network connection has been made or released.  

  

Clipboard Text 
The Clipboard Text activation method starts a macro based on the contents of the clipboard. Select whether the clipboard 

does or does not match the text supplied in the edit field. Or choose whether the clipboard contains or does not contain 

the text.  

  

Floating Menu       

A floating menu has the same form and options as a Popup Menu except that it always remains on top and is always 
accessible as long as the Macro Player is running. A floating menu can be minimized to just the caption bar to free up 

space if needed. Multiple floating menus can be created. The last location of the floating menu is retained and used with 

subsequent runs of Macro Express. Use the Build Macro Menu window to select which macros to include in the floating 
menu. 

  

None 
This option does not assign an activation to the macro. There are at least two possible uses for the No Activation option. 

First, create generic macro templates that can be incorporated into other macros - a set of instructions that may be 



useful for insertion into other macros. Use the Macro Run command to insert this type macro into other macros.  

  

A second use for this option is to place the macro in a popup or floating menu . A macro activation is not necessary if the 

macro is part of a popup or floating menu. The only way to invoke the m acro would be through the menus.  

  

 

  

Macro Nickname 
Assign a name to the macro to help remember what the macro does. The nickname, along with the activation, is 

displayed in the Macro Explorer and is optional.  

  

Build as a Popup Menu          

Selecting a Popup Menu activates the Menu Builder. After selecting the activation, check the Build as a Popup Menu box 
and click OK to open the Menu Builder window. In this window select which macros to include in the popup menu. When 

activated, the popup menu displays all macros included in the menu. Choose which one to run from the menu.  



 

Capture Macro Introduction 
 

The simplest type macro to create is a recorded macro. The macro records each keystroke, mouse click or mouse 
movement made. After saving the macro, play back the macro and watch it repeat each of the steps just recorded. If a 

mistake is made in the recording, either re -record the macro or edit the macro with the Script Editor. 

  

The first step before capturing a macro is to select capture op tions, such as whether to record mouse movements, 
playback speed, base the mouse position relative to the position of the window or entire screen, etc. Use the Options | 

Preferences | General | Capture menu to define the default capture settings.  

  

Each time a capture is started, the options selected are stored as the default values. If a change to one of the settings is 
necessary for a particular recording, make the change before the capture starts.  

  

There are two different ways to initiate a macro captur e. Examples for using both of these methods are outlined in the 

Tutorial section of the Help file and also in this section for convenience.  

  

Assign Macro Activation First 
Click on the Capture Icon or Macro | Capture Macro from the menu to start the captu re process. This method requires 

selecting the macro activation and reviewing or changing the default capture options before starting the capture.  

  

Assign Macro Activation After Capture 
The second method uses the System Macro, Ctrl+Alt+Shift+X. While in a nother application, press the System Macro to 
begin capturing a macro in that application. This method uses the capture default settings that were defined in the 

Preferences section. After the capture is complete, follow the prompts to assign a macro activ ation. 



 

Quick Wizards 
 

The Quick Wizards are a convenient way to step through the macro creation process. The sequence is essentially the 
same for each of the wizards and are basically self explanatory. We'll briefly discuss the basic steps of the wizard. 

  

Wizard Steps 
1. Select the category or type of macro to create and then click on the Next button.  

2. The second step prompts to select the specific type of macro to create. Click Next to advance. 

3. A window opens listing the functions of the wizard selected as well as giving some examples of macros that may 

be created with this wizard. Click Next to advance to the next screen.  

4. Depending on the wizard selected, a prompt appears asking what to do w ith the macro or instructions are 
provided to begin building the macro. Input the necessary information and click next to proceed.  

5. After entering the necessary information for the macro, the next step is to select a method for executing the 

macro - hot key, timed macro, etc. Select an activation method and click Next.  

6. Define if the macro should play back in all programs, a single program or only in a specific window. Make a 

choice and click Next to proceed. 

7. Give the macro a nickname and optionally assign an icon with the macro.    

8. Click Finish and the macro is complete. 

  

These are the basic steps of the Wizard. Depending on the wizard selected there may be several additional steps, each of 

which is self explanatory. Each step has a Cancel button to exit the Wizard at any time. Each step includes a Back button 
to backtrack and make any changes needed. 

  

The Wizards have been divided into categories based on their functionality. Each of the links below lead to brief 

explanations of each of the wizards and some of the types of macros that can be created. The Tutorial section includes 
an example of creating a macro with the Wizard.  

  

Text  

Internet and Networking  

Multimedia 

System and Files 

  

Note:  The Quick Wizards are handy for less complicated macros. If planning to use If / Then logic, variables or other 
advanced features, the macro will need to be created with the Script Editor.  



 

Edit Macro 
 

There are several ways to edit an existing macro. In the Macro Express Pro - Explorer window highlight the macro to be 
edited. Then take one of the following steps:  

  

1. Click on the Edit Macro icon 

2. Click on the speed button   

3. Click on Macro | Edit Macro from the menu  

4. Double click on the macro in the Explorer list 

  

The above action opens the Script Editor where changes may be made to the macro script.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Edit  Macro 

 



 

Copy Macro 
 

Macro Express provides for a simple method to copy of an existing macro. From the Macro Express Pro - Explorer window 

highlight the macro to copy. Then click on Macro | Copy Macro from the menu or the Copy Macro speed button . The 

Create New Macro window appears prompting to select a new macro activation for the copied macro. Select the macro 

activation, change the macro nickname and click OK to save. The new macro is now displayed in the Macro Explorer 

window.  

  

If the macro nickname is not changed it will be displayed as "copy of" followed by the name of the original macro.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Copy Macro 



 

Enable or Disable Macro 
 

To temporarily disable a macro, highlight the macro from the list in the Macro Express Pro - Explorer. Then click on Macro 
| Disable Macro. Disabled macros appear in the Macro Explorer with italicized red text to distinguish from active macros. 

A disabled macro will not function again until it has been Enabled. To enable the macro, highlight the disabled macro 

with the mouse and click on Macro | Enable Macro. The macro is now ready for use again.   

  

If a macro is disabled it will not execute, but the defin ition is retained for potential future use. This is helpful for those 

instances where a particular macro is not needed for a time, but may be needed later. Instead of deleting it and 

re-creating the macro later, simply disable it and then re -enable in the future.  

  

Floating Menus 
When closing a floating menu by clicking on the "X" in the upper right corner of the menu window, the floating menu is 
disabled. To enable the menu highlight the floating menu from the list of macros in the Macro Explorer and click  on 

Macro | Enable Macro. 

  

Macro Disable and Macro Enable Commands  
Also use the Macro Disable and Macro Enable commands in macros themselves to enable and disable other macros in the 

macro file - such as Floating Menus or Scheduled macros.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Enable Macro/Disable Macro 



 

Recapture Macro 
 

To overwrite the results of a previous captured macro, highlight the macro from the Macro Express Pro - Explorer list and 
click on the Macro | Recapture Macro. This opens the Capture a Macro window to check the capture settings before 

recording. Then click the Capture button to start the macro capture.  

  

Press the system hot key Ctrl + Alt + Shift + X, right click on the camera icon in the system tray or press the hot key 
combination of the macro being recaptured to stop the capture.  

  

Recapturing removes the contents of the existing macro and replaces it with the newly captured script.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Recapture Macro 



 

Delete Macro 
 

To remove a macro that is no longer needed, first highlight that macro from the list in the Macro Express Pro - Explorer. 

  

There are several ways to delete the highlighted macro.  

1. Click on Macro | Delete Macro(s) from the menu.  

2. Click on the Delete speed button   

3. Press the Delete key on the keyboard.  

4. Right mouse click on the macro and left click on the Delete Macro menu item.  

  

A dialog window opens to verify that the macro should be deleted. S elect Yes to confirm the deletion or No to cancel.  

  

For mass deletions highlight a group of macros and delete them all at the same time.  

  

Deleted macros are sent to the Macro Express Recycle Bin. If necessary a deleted macro can be restored to its origi nal 

macro file. Or periodically empty all macros from the Recycle Bin.  

  

Note:  To bypass the Macro Recycle Bin highlight the macros to be deleted and press Shift + Delete. This permanently 
deletes the macros without placing them in the Macro Recycle Bin. 

  

  

Macro Delete Command 
The Macro Delete command deletes other macros during macro playback. Insert the command at the end of a macro 
script and the macro can delete itself upon completion of the playback.  

  

This feature is handy for use with one -time reminder messages. The macro runs at its appointed schedule, displays the 

reminder and then is deleted upon completion. The reminder macro doesn't need to remain in the Macro Explorer list 
after it has run.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Delete Macro 



 

Run Macro Now 
 

This option does what it's title implies. Highlight the macro to run from the Macro Express Pro - Explorer. Click on Macros 

| Run Macro Now or the speed button  to run the macro. Of cou rse, make sure that the macro to "Run Now" is 

appropriate for the window currently open, etc.  

  

Another way to accomplish the same thing is to right mouse click on the macro in the Macro Explorer to open the context 

menu. Left mouse click on the Run Macro Now menu item. 

 

 
Highlight macro in Macro Express - Explorer > Macro > Run Macro Now 



 

Move to Category 
 

Use this menu command to assign macros to categories already created. Highlight the macro to be assigned and click on 
Macros | Move to Category to display a list of categories such as in the example below. Highlight the category to move 

the macro into and press the OK button. The macro is now assigned to the category selected.  

  

 
Macro Express Explorer > Macro > Move to Category 

  

The other method is to drag the macro from the Macro Express Pro - Explorer list to the desired category. To drag the 

macro, highlight the macro, hold down the left mouse button and move the pointer to the category listed in the Category 
column. When the mouse is pointing to the correct category, release the left mouse button. The macro is assigned to the 

category. Expand the category to view all macros stored in that category.  

  

With either of the above options, also highlight a block of macros and move th em all at once to the category of choice.  

  

Note:  The categories selected are specific to the macro file that is currently open. When opening a new macro file, the 
categories created for the new file are displayed. If more than one macro file is open, mult iple sets of categories are 

displayed, one set for each macro file. 



 

Place on Desktop 
 

Use this option to place an icon of any macro onto the desktop. In order to do this, highlight the macro from the list of 
macros in the Macro Express Pro - Explorer. Then click on Macros | Place on Desktop. The icon previously assigned to the 

macro is displayed on the desktop.   

  

Selecting a Desktop Icon  

Change a macro's icon by double clicking on the macro from the list of macros in the Macro Explorer to open the Script 
Editor. 

  

 
  

The icon (in the example above, a blue number one) is displayed to the left of the macro nickname. Click on the icon to 
open the Select an Icon window. Click on the browse button to open a folder with a n umber of icon options. Or navigate 

to another location on the hard drive where other icons may be found on the computer. If an icon was not selected at 
the time the macro was created, the default Macro Express icon is displayed. 

  

Note 1:  When creating an icon on the desktop, the macro nickname also becomes the file name. Windows does not 

accept several characters as part of a file name, one of them being the / symbol. Other characters not allowed are \  : * ? 
< > | : ? and *.  

Note 2:  To remove an icon from the desktop, right mouse click on the icon and select delete from the menu that opens.  

 

 
Highlight macro in Macro Express - Explorer > Macro > Place on Desktop 



 

Macro Properties 
 

This view of the Properties window may be accessed from the Macro Express Pro - Explorer in several ways. Highlight the 
macro of interest and click on Macros | Properties from the Macro Explorer menu or click on the Properties speed button 

. The other method is to right mouse click on the macro a nd left click on Macro Properties from the context menu. 

Each accomplishes the same thing.  

  

 
Macro Express Explorer > Right Click on a Macro > Left Click on Macro Properties 

  

The following information is available about the macro selected.  

  

General 
This Tab provides some basic information about the macro such as the last modified date or scheduled time if a 
scheduled macro. Click on the check box to change the status of the macro from Enabled to Disabled or vice versa. This 

panels also allows editing of the Macro Name. 

  

Activations 
This tab displays what activation(s) are in use for the macro. The activation(s) may be modified from this screen.  

  

Scope 
The Scope tab displays the macro scope and any programs or windows assigned if using Program or Window Specific 

scopes. The selections may be modified from this panel. 

  

Security 
The Security Tab allows for changes to the existing passwords assigned to the macro or to add a password. 

  

Logging 
The Logging Tab displays any error logging that the macro is defined to use. The logging options are set in Preferences | 
Playback | Miscellaneous and will log errors or will log all commands in the macro, depending on the option selected.  

  

The field in this tab is not editable. Click on the Clear Log button to re move all log entries. 



 

Macro Recycle Bin 
 

The Macro Express Recycle Bin works similar to the Windows Recycle Bin. When a macro is deleted from the Macro 
Express Pro - Explorer, the macro is removed from the macro file that is currently open. The deleted m acro is sent to the 

Macro Express Recycle Bin and is displayed in the bin along with any other macros previously deleted from the current 

file. 

  

Note:  Highlight the macro or macros in the Macro Explorer window and press Shift + Delete to permanently delete the 

macros and bypass the Macro Recycle Bin. This step permanently deletes the macros with no chance for recovery. 

  

Three options are available in the Recycle Bin - Restore Macros, Delete Macros or Empty Recycle Bin. 

  

Restore Macro(s) 
The Restore Macros option returns a deleted macro from the recycle bin back to its original file. The macro is again 

available for use in the Macro Express - Explorer. This is a quick way to restore accidentally deleted macros. 

  

To restore, highlight one or more macros in the Deleted Macro list. To highlight a block of macros, click on the first macro 

to restore, hold down the Shift Key and click on the last macro in the  block. Click on the Restore Macro(s) option to place 

the deleted macros back into the macro file from which they were deleted.  

  

Delete Macro(s) 
Delete Macros permanently removes the selected macros from the Recycle Bin with no chance to retrieve later. To 
remove, highlight one or more macros in the Deleted Macro list. To highlight a block of macros, click on the first macro to 

delete, hold down the Shift Key and click on the last macro in the block. Click on the Delete Macro(s) option to remove 

from the Recycle Bin.   

  

Empty Recycle Bin 
Click on the Empty Recycle Bin option to remove all macros from the Recycle Bin. These macros cannot be retrieved once 
they are removed from the Recycle Bin. 



 

Using Categories 
 

Use this option to assign macros to categories. For example create a Password category to hold any macros containing 
important passwords or assign any MS Word specific macros to a MS Word category. The categories provide a simple 

way to find macros after they have been created. A macro may only be assigned to one category. 

  

When the program is first installed, there are two default categories - All Categories and Unassigned. These may not be 
changed, but new categories may be added, or later deleted or renamed. All Categories displays all of the macros in the 

file. The Unassigned category displays all macros not assigned to a category other than All Categories. The category 

icons may be turned on or off via the Macro Express Pro - Explorer menu Options | Preferences | Appearance |  
Explorer tab. 

  

 

  

New Category 
Select this menu option to add a new category. A new category folder and edit box appears in the category list. Type in 
the name to assign the category. Also create sub-categories within the category list. To do thi s, right mouse click on the 

main folder and then left mouse click on New Category. A new category sub-folder is added to the list.  

  

 
Macro Express Explorer > Category > New Category 

  

Rename Category 
To change the name of a category already created, highlight the category and click on the Category | Rename Category 

menu option. The category name is highlighted so that a new name may be inserted, similar to the way Windows 
Explorer works.  

  

Enable/Disable Category 
This option disables or enables all of the macros in the category selected. If the category contains both enabled and 
disabled macros, then the status is toggled. The enabled macros are now disabled and the disabled macros in the 

category are enabled. 

  

Delete Category 
Highlight the name of the category to remove. Then click on Category | Delete Category. A warning message appears 
verifying that the deletion should continue. Click Yes to delete the category and all of it's sub -categories. 

  

 

  

Placing Macros in Categories 
Once a category is created, there are two methods for moving macros into a category.  

  



Highlight the macro to be assigned and click on Macros | Move to Category to display a list of categories such as in the 

example below. Choose the category to move the macro into and press the OK button. The macro is now assigned to the 
category selected. 

  

 
Macro Express Explorer > Macro > Move to Category 

  

The other method is to drag the macro from the Macro Explorer list to the desired category. To drag the macro, highlight 
the macro, hold down the left mouse button and move the pointer to the category listed in the Category column. When 

the mouse is pointing to the correct category, release the left mouse button. The macro is assigned to the category. 
Expand the category to view all macros stored in that category.  

  

Using either of the above methods, highlight a block of macros and move them all at once to the category of choice. 

  

Note:  The categories selected are specific to the macro file that is currently open. When opening a new macro file, the 

categories created for the new file are displayed. If more than one macro file is open, multiple sets of categ ories are 
displayed, one set for each macro file. 



 

Set/Clear Password(s) 
 

This menu option provides password protection to a category of macros. Select whether to prevent users from running, 
editing or viewing macros in the selected category. Selecting All Categories effectively password protects the entire macro 

(.mex) file. The Lock icon indicates that a password is currently in place.  

  

 
Macro Express Explorer > Category > Set/Clear Password(s) 

  

Run Password 
None of the macros in the password protected category will run without first typing the password. When a macro is 
activated, a prompt appears requesting the password be input. Once the password is successfully entered, the macro 

starts running.  

  

Edit Password 
The macros in the password protected category are displayed, but may not be edited without first typing the password.  

  

View Password 
None of the macros in the password protected category are displayed without first typing the password. Once the 

password is successfully input, the macros in the category may be viewed, edited, saved or deleted. Once another 
category is opened, the password must be typed again to reenter the password protected category.  

  

 

  

Create a New Password 
To create a password for the first time select the Run, Edit or View option and click on the Change button. Leave the 
Original Password field empty and enter the password in the New Password field. Confirm the password in the Confirm 

Password field and save.  

  

Change an Existing Password 
To change an existing password select the Run, Edit or View option and click on the Change button. Enter the current 

password in the Existing Password field. Insert the new password in the New Password field. Confirm the password in the 
Confirm Password field and save. 

  

Note:  Leave the New Password and Confirm Password fields blank if removing a password from the category. 

  

  

Related Topics  

  



 

Find 
 

Use the Find feature to search through the list of macros in the Macro Express Pro - Explorer window. It performs the 
search beginning with the macro highlighted and continues through the rest of the list. Pressing CTRL + F or clicking on 

Search | Find will open the Find window.  

  

 
Macro Express Explorer > Search > Find 

  

Find what: 
Enter the details of the search (what is to be found) in this field.  

  

Search in: 
Perform the search on the Nickname, Activations, Scope or Modified columns in the Macro Explorer window. Select which 
column to search through.  

  

After entering the search criteria press the Find Next button. If a match is found, the macro that matches is highlighted. 

If no match is found, a message "Reached the end of the list" is displayed.  

  

Match case 
This option makes the search case sensitive. Capital and lower case letters need to match exactly in order to find the 
right match.  

  

 

  

Find Again 
If the first match is not the macro being sought, press F3 or click on Search | Find Again to go to the next  match. 

  

  

 

 



 

View 
 

The View functions customize the look of the Macro Express Pro - Explorer window.  

  

Toolbar 
From the Macro Explorer menu, click on Options | View and select to display the toolbar (similar to what is shown below). 

The toolbar is not displayed in the Macro Explorer window when the option is not selected.  

  

 
  

Sidecar 
From the Macro Explorer menu, click on Options | View and choose to display the sidecar (similar to what is shown 

below). The sidecar is not displayed in the Macro Explorer window when the option is not selected.  

  

 



 

General Activation 
 

 
Macro Express Explorer > Options > Preferences > Activation > General Tab 

  

Auto Restore the Keyboard and Mouse Hooks 
This feature automatically attempts to have Macro Express re-assert itself as the first program to take a look at the 
keystrokes passed through the Windows system wide keyboard hooks even if other programs are loaded that also use 

these keyboard hooks. 

  

Typically this is not a problem unless a program is run *after* Macro Express and it uses the keyboard hooks and it 
places itself there in an improper fashion. When this occurs, keystrokes are no longer passed onto Macro Express and the 

Macro Express Hot Keys and ShortKeys suddenly fail to trigger macros.  

  

This feature should automatically give Macro Express first looks at the keystrokes thus preserving the use of Macro 
Express Hot Keys and ShortKeys. In addition, because Macro Express properly passes on keystrokes through the chain of 

keyboard hooks, other programs will still funct ion correctly. 

  

The above also applies to the Windows mouse hooks. 

  

  

Use the Clipboard Hook 
This option turns on or off the ability to run clipboard activated macros. Select this option to allow clipboard activated 
macros to run. If conflicts arise with  other programs using the clipboard, turn off this option.  



 

Scheduler 

 
Macro Express Explorer > Options > Preferences > Activation > Scheduler Tab 

  

Alarm 
Set the Alarm to alert through the play of a sound (.wav) file when a scheduled macro is about to execute. The default 
option is to not play any sound.  

  

Sound File 

Enter the file name and path of the sound file into the Sound File field. Or click on the B rowse button to locate the sound 

file.  

   

Wait for the sound file to finish 

Placing a check in the box causes the playback of the macro to stop until the sound file has finished playing. The 

macro resumes playback once the sound file has finished. 

           

   

Timer Interval 
Specify the interval, in seconds, for how often Macro Express checks to see if a scheduled macro is ready to execute. 
Macro Express will shut off the timer if no scheduled macros exist in the current file or none are active. The defau lt 

setting is to check for scheduled macros every 10 seconds.  

  

Suppose a scheduled macro plays back every 3 seconds. For the macro to work correctly, the Timer Interval needs to be 
set to check at least every 3 seconds. Otherwise some of the scheduled times will not run.  

  

 

  

Disable the Screen Saver when there are Scheduled Macros  
Screen Savers prevent a scheduled macro from running. This option prevents a screen saver from starting if Macro 
Express is running and if there are any active scheduled macros in the macro file currently in use. It stops the screen 

saver from starting, allowing the macro to run.  



 

ShortKeys 
 

 
Macro Express Explorer > Options > Preferences > Activation > ShortKeys Tab 

  

A shortkey is a set of characters such as abc, myname, etc. The macro runs when the characters are typed into an 

application. Click on Options | Preferences | Activations and the ShortKeys tab to define the settings. Below are 

descriptions of the default settings that can be assigned to all shortkeys.  

  

Prefixes and Suffixes 
The Prefix Key and Suffix Key options cannot be overridden elsewhere in the program.  

  

Use Prefix Keys 

The Prefix Keys are used to designate up to three characters that may be added to the beginning of every shortkey. A 
prefix key is a method to prevent the accidental triggering of a macro during everyday typing.  

  

This option places a prefix key or keys, such as z, ##, qq, etc., in front of each shortkey. So, if the Prefix Key was set to 

## and the shortkey was set to "test", typing ##test starts the macro. Typing ## before any text would make it very 
unlikely for a macro t o start accidentally. 

  

The other option is to leave the Prefix Keys field blank. In the above example, typing the shortkey "test" would start the 

macro. No other keys are required. 

  

Below is a list of the Prefix characters that are recognized by Macro Express.  

  

o   The letters A through Z (both upper and lower case)  

o   The numbers 0 through 9 

o   The following characters:  !  @  #  $  %  ^  &  _  =  <  >  ?  .  ;  ,  *  -  /  +  `  '  "  )  ] and space bar 

  

Shortkey Detection 

The program provides two methods of "shortkey" detection. They are the Solitary Usage and the non Solitary Usage. 
A check mark in the box beside the solitary usage option indicates that the solitary usage option is activated. The 

non solitary usage option is the default setting.  

  

Solitary Usage 



The solitary usage option indicates that a shortkey is recognized only when the shortkey is preceded by a 

character or key that is not valid as part of the shortkey name. This is best illustrated by the example belo w.  

  

Assume the shortkey was named red and the macro text was a bright color. The replacement would not take 
place if the word Fred were typed. Why? Because "F" is a valid character in a short key name. We really didn't 

want the replacement to take place because we were typing Fred and not red.  

  

However, if typing the word red preceded by a blank space, the replacement would take place. Why? Because a 
blank space is not valid as part of a shortkey.  

  
Non Solitary Usage 

The non solitary usage option (leaving the Solitary Usage option unchecked) indicates that a shortkey will be 
recognized whenever the short key text is typed, even if it is part of another word. The following example 

illustrates this point.  

  

Assume the shortkey was named red and the macro text was a bright color. Typing the word Fred would cause 
the macro to start and the text typed would be Fa bright color.  

  

Typically the "non solitary usage" mode is used with a prefix key or two to ensure that a macro does not play 

back unintentionally. 

  

Use Suffix Keys 

Another alternative is to use the Suffix Keys option. With this option activated, type the shortkey and then press down 
either the Space Bar or the Enter Key to activate the macro.  

  
Use Punctuation Characters 

Punctuation keys such as . , : ; ? ! ) ' ] " ` and - may also be used as a suffix key for a shortkey when the Include 
Punctuation Chars box is selected. If the shortkey was set to test, type the word test while in another Windows 

application and press either the Space Bar, Enter Key or one of the punctuation keys listed above to start the macro.  

  
Retype Suffix Key  

The Retype Suffix Key option, when checked, types the suffix key (Enter, Space or punctuation keys) to the end of 
the macro text. This option is mainly for those who use shortkeys as a simple text replacement in writing documents.  

  

Assume a shortkey of test with a replacement text of This is a test. Typing the word test into notepad or other text 

editor and using the space bar as the trigger causes the macro to start. The replacement text is typed into the 
application and the cursor moves one space to the right of the text.  

  

Or typing test and using the ? to activate the shortkey causes the replacement text to appear with a ? at the end of 

the text. If the Replay Suffix key is not selected, the suffix key is not placed at the end of the replacement text.  

 



Complete list of characters that can be used with shortkeys 

 

Up to 32 characters may be entered as an original short key (which are to be replaced). In 
addition, up to 3 Prefix Keys may optionally be entered in that are applied to all Original 

Shortkeys created. The following Prefix characters may be entered and used:  

  

  The letters A through Z (both upper and lower case)  

  The numbers 0 through 9 

  The following characters: 

!  @  #  $  %  ^  &  _  =  <  >  ?  .  ;  ,  *  -  /  +  `  '  "  )  ] and space bar 

  

If not using a prefix key, use the suffix key and press the space bar, the enter key or a 
suffix character of . , : ; ? ! or - after typing the shortkey to activate the macro.  



  

  

Note:  Pressing down the CTRL or ALT key is detected by the program when using the Shortkeys option, and is 
interpreted as a key being pressed. Therefore, if the ALT or CTRL key is pressed in the middle of a shortkey being typed, 

the shortkey will not be recognized and the macro will not start.  

  

 

  

Case Sensitivity 
The following options are the default options used for each new shortkey created. These options can be overridden on an 
individual shortkey basis. 

  

Match First Character's Case Between ShortKey & Replacement Text 

This option causes the upper case setting of the first letter in the shortkey to dictate that the first character in the 
macro will be upper case (if the first thing in the macro is a character). This option is mainly for those doing simple 

text replacement in documents and facilitates an easy way to capitalize the replacement text in instances where it 

needs to be, such as at the beginning of a sentence. 

  
Require Exact Upper Case/Lower Case Match on ShortKey 

With this setting selected, the shor tkey must be typed exactly as it appears (upper and lower case letters) in order 

for the replacement to work. Without case sensitivity, the shortkey may be typed in either upper or lower case to 
start the macro. Here are a few examples:  

  

ShortKey Case Sensitive Not Case Sensitive 

Mike  Mike mike 

tagline tagline Saline 

Address  Address address 

  

No Case Sensitivity 

Neither of the above cases apply with this option checked.   

  

 

  

Other 
Do Not Remove Keystrokes Typed 

This option instructs the shortkey to not erase itself after being typed. Normally, backspaces are issued to remove the 

shortkey from the screen before the macro is executed.  

  

When using shortkeys in non-text usage programs, it may not be desirable to ha ve "backspaces" issued. For example, 
using a shortkey in Internet Explorer where focus is not on an edit box, will cause the "back" button to be pressed 

numerous times due to the backspaces being issued. The Do Not Remove Keystrokes Typed option will prevent this from 

happening. 

  

 

  

Characters 
Use this option to define acceptable characters for use with the Suffix activation method and characters not allowed for 

use as a Prefix.   

   

Invalid Characters  

One or two Prefix Keys may optionally be input that a re applied to all original shortkeys created. The following Prefix 

characters may be entered and used:  

   

o The letters A through Z (both upper and lower case)  

o The numbers 0 through 9  

o Others: Essentially any other valid character or symbol such as ! @ # $ % ^ & _ = < > ? . ; , * - / + \ .  

   

This list of Invalid Characters provides a method to remove characters for use as a prefix key. Attempting to assign 



an invalid character as a prefix would not be allowed.  

   
Punctuation Characters  

The Suffix activation method allows the use of punctuation characters to trigger the macro. The Preferences image 
above displays the default list of punctuation characters that can be used to activate a shortkey macro. Punctuation 

characters may be added or removed from this list.   



 

Explorer 
 

All 
Macro Express Explorer > Options > Preferences > Appearance > Explorer Tab 

  

Use these options to adjust the look of the Macro Express Pro - Explorer window. 

  

Show Category Icons 
This option displays folder icons next to each category in the Category field of the Macro Explorer. 

  

 

  

Show Macro Icons 
This option displays icons next to each macro listed in the Macro Explorer. If an icon has not been assigned to the macro, 

the default Macro Express icon is displayed. 

  

Show Grid Lines 
This option displays grid lines between each macro displayed in the Macro Explorer.  

  

Show Preview Pane 
Select this option to display a panel at the bottom of the Macro Explorer list when a macro from the list is highlighted. 

The panel provides additional details about the highlighted macro.  

  

Color Every Other Line 
Select this option to display every other macro in the Macro Explorer list with a shaded background. This helps to read 
across the line easier. 

  

Draw a Line Through Disabled Macros 
This option draws a line through any disabled macros displayed in the Macro Express Explorer window. This makes it 
more readily apparent that the macro is disabled.  

  

All disabled macros are displayed with italicized red font. 

  

  



 

Script Editor 
 

 
Macro Express Explorer > Options > Preferences > Appearance > Explorer Tab 

  

Script Font 
Use this option to select the font type, color, size, etc. to display in the Script Editor.  

  

Use Default Color 

This option sets the Editor color to match the Windows default system colors or the color scheme in use on the computer.  

  

Display Command Category Icons 

Each group of macro commands in the Script Editor, such as CD-ROM, Logic, etc., has a distinct icon associated with it. 
Each time a command from that group is used and added to the macro script, the associated icon is also displayed in the 

script.  

  

If not selected, the icons are not displayed in the category list or next to each command in the macro scri pt. 

  



 

General Email Settings 
 

 
Macro Express Explorer > Options > Preferences > Email > General Tab 

  

Use MAPI to send Email 
Select this option to send messages through the default email program rather than using the Macro Express email client. 
Macro Express will only be able to send email using the default email client if it is compatible with the Messaging 

Application Programming Interface (MAPI). Mainstream email programs such as Outlook, Eudora, Thunderbird, etc. are 
compatible. 

  

If using this option, the SMTP Settings tab changes to a MAPI Settings tab so the options can be set.  

  

  

Keep a Log of All Messages Sent 
This option logs all email messages sent through Macro Express to an email log file. From the Macro Explorer window 

click on Tools | Sent Email Log to review the mails sent via Macro Express.  

 

 

Related Topics  



 

SMTP Settings 
 

To successfully use the email commands via SMTP, the default email settings need to be entered into the SMTP settings 
panel. Click on Options | Preferences | Email to enable the email functions of Macro Express.  

  

 
Macro Express Explorer > Options > Preferences > Email > SMTPSettings 

  

Server Settings 
The SMTP Server is what allows email to be sent over the Internet. The server settings may be obtained from the 

Internet Email provider or from the configuration section of t he default email program on the computer.  

  

Host - The "Host" value may appear as a series of numbers and periods such as 192.168.0.1 or as a set of 

characters looking something like a web site name such as mail.myisp.com. 

Port - The port number is almost always 25. When in doubt, set this value to 25.  

  

 

  

Authentication 
The SMTP Server Requires Authentication 

The email provider may require use of SMTP Server Authentication. If so, select this option and insert the user name and 
password in the appropriate fields. If authentication is not required, then leave this option unchecked.  

  

 

  

Email Address 
This is the name and email address that display in the return address of any email sent through Macro Express. Please 

note that if the email address entered is incorrect, the recipients of the email may not know how to reply to the message.  

  

  

Related Topics  



 

MAPI Settings 
 

B 
Macro Express Explorer > Options > Preferences > Email > MAPI Settings 

 

This option is only available if MAPI is selected in the Email > General tab. 

 

The MAPI information - Profile Name and Password - is only required if using multiple email profiles. Enter the email 

Profile to use with Macro Express and the password. 

  

If not using multiple email profiles then this information should be left blank.  

  

  

  

Related Topics 



 

Address Book 
 

The Address Book is a list of names and email addresses to choose from when creating email macros. Use this function to 
add names, make changes to existing names or delete names from the list. Click on Options | Preferences | Email to 

access this option. The Email Send command also has an option for editing the list of email recipients.  

  

 
Macro Express Explorer > Options > Preferences > Email > Address Book Tab 

  

Add 
Click on the Add button to open the Email Recipient Maintenance window shown below. The two fields will be blank. Just 
enter the person's name and email address and click OK to add that person to the list.  

  

 
Address Book Window > Add or Modify Buttons 

  

Modify 
If the email address has changed for someone on the list or other information needs to be changed, highlight that 

person's name from the list and click on the Modify button. The name and email address are displayed in the Email 
Address window as shown above. Edit this information and click OK to save the changes. 

  

Remove 
To remove a person from the email recipient list, highlight that person's name and click on the Remove button. The name 

will be removed from the list.  

  

 

Related Topics  



 

File Paths 
 

Use this option to set the default file locations for a number of files used by Macro Express. Descriptions of the files are 
provided below. 

  

 
Macro Express Explorer > Options > Preferences > File System > File Paths 

  

Address Book 
This specifies the path and name of the file that holds any email addresses to be stored. This option is provided so that 
network users can each have their own individual list of email addresses. If email addresses are common to all users, 

simply point each user to the same file.  

  

Sent Email Log 
The Sent Email Log field displays the path and name of the file that logs the mails sent via Macro Express. The email 

information will only be saved to this file if the Email Logging option has been set. Start a new log file at any time by 
changing the file name. 

  

Default Error Log Directory 
This specifies the path and name of the file that holds the error logs created when using the Log Errors command. Start a 

new log file anytime by changing the file  name. This option is provided so that network users can each have their own 
individual list of error messages. If error messages are common to all users, simply point each user to the same file.  

  

Crash Report Directory 
This specifies the path and folder where crash reports are saved. Crash reports are generated by an unexpected closing 
of the program. The details of the problem are saved to a file that begins with 'error' and ends with '.TX' in the folder 

specified here. The default path is the folder whe re the Macro Express program is installed. 

  

Default Keyboard Remapping Directory 
This specifies the path and name of the file that contains the Remap Keyboard information. By default, this is stored in 

the same folder where Macro Express is installed. On some systems, a user cannot change files in the folders where a 
program is installed. In such cases store the Keyboard Remapping file in the same folder where the macro file is located.  

  

Temporary Capture File Name 


